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RESUMO 
 

A contribuição desta pesquisa é dada através do dimensionamento dos impactos 
efetivos das rodovias, através da ampliação das áreas de influência para além das 
faixas lineares, acrescentando a avaliação da sensibilidade ambiental das bacias 
hidrográficas para a otimização do traçado de empreendimentos rodoviários. Foi 
produzida uma abordagem ordenada e sistemática das relações de causa e 
conseqüência nas bacias, integrando os impactos da rodovia TO-247, interligando as 
sedes municipais Lagoa do Tocantins e Mateiros. As sub-bacias da região da área do 
estudo foram classificadas mediante metodologia para estimativa de produção e 
transporte de sedimentos, em ambiente ArcGis ArcInfo, onde foi aplicado modelo 
derivado da Equação Universal da Perda de Solos (Universal Soil Loss Equation – 
USLE) adaptado de Wischmeier e Smith (1978) e da Relação de Distribuição de 
Sedimentos (Sediment Delivery Ratio – SDR) proposto por Ferro e Minacapilli (1995). 
Os resultados possibilitaram a classificação das sub-bacias conforme a porcentagem 
estimativa de carga de sedimentos que potencialmente viria a assorear os cursos 
d’água mediante a modificação do seu uso pela ocupação do solo induzida pela 
rodovia. Os critérios relevantes à definição do traçado da rodovia foram divididos em 
três: (1) aspectos ambientais, (2) aspectos construtivos e (3) aspectos 
socioeconômicos, tendo sido parametrizados através do uso de Sistema de 
Informação Geográfica com algoritmos em ambiente raster, na definição de caminhos 
de mínimo custo. A otimização da rota proposta sugere a adição de ganhos na 
orientação dos tomadores de decisão, como a inserção da rodovia TO-247 em bacias 
com menor nível de restrição de relação de aporte de sedimentos, redução das 
travessias sobre áreas protegidas, diminuição das obras de arte (bueiros e pontes) e 
da execução de cortes e aterros, incluindo a possibilidade de melhoria dos acessos 
aos pontos turísticos de interesse para o desenvolvimento regional. A incorporação de 
condicionantes hidrológicas através da classificação das bacias quanto a produção e 
transferência dos sedimentos destacou a principal novidade que foi a definição da 
área de influência delimitada pelos impactos ambientais de projetos rodoviários para 
os limites das bacias, podendo contribuir com o planejamento de estradas indutoras 
de desenvolvimento. 

 
Palavras-chave: bacias hidrográficas, rodovias, usle e sdr, área de influência, 

caminhos ótimos. 
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ABSTRACT 
 

The contribution of this research is given by the design of effective impacts of 
highways, through the expansion of the influence areas beyond the linear tracks, 
adding the assessment of the environmental sensitivity of watersheds in order to 
optimize the layout of road projects. It was produced an orderly and systematic 
approach of the cause and consequence relations in the watersheds incorporating in it 
the TO-247 highway impacts, linking the cities of Mateiros and Lagoa do Tocantins. 
The watersheds in the region of the study area were classified using methodology for 
estimating production and transport of sediment in ArcGIS ArcInfo environment. It was 
applied the equation model derived from the Universal Soil Loss Equation - USLE 
adapted from Wischmeier and Smith (1978) and the Sediment Delivery Ratio - SDR 
according to what is proposed by Ferro and Minacapilli (1995). Those results allowed 
the classification of watersheds according to the percentage estimate of sediment load 
that would potentially silting up the waterways through modification of their usage by 
land use induced by the highway. The relevant criteria to define the highway route 
were divided into three: (1) environmental, (2) construction and (3) socioeconomic 
aspects, which have been parameterized by using Geographic Information System 
with algorithms in raster environment into the definition of low cost paths. The 
optimization of the route proposal in TO-247 suggests adding profit in orientation of 
decision makers, such as entering the highway in watersheds with lower levels of 
restriction regarding the amount of sediment, reduction of crossings on protected 
areas, reduction of culverts and bridges and the implementation of sections and 
embankments, including the possibility of improved access to interest tourist points 
for regional development. The incorporation of hydrological conditions through the 
classification of river watersheds as the production and transfer of sediments, which 
highlighted the main novelty, was the expansion circumscription of the influence area 
bounded by the environmental impacts of road projects for the limits of the watersheds, 
which may contribute to the planning of roads inducing development. 
 
 Keywords: watershed, roads, USLE and SDR, influence area, optimal paths. 
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1. APRESENTAÇÃO 

 

1.1. Introdução 

 

Os problemas ambientais provocados pela implantação de projetos 

rodoviários, como de outras áreas, decorrem, em grande parte, das carências do 

processo decisório que orienta a utilização dos recursos ambientais. 

O planejamento ambiental deve prever a realização de estudo prospectivo 

que visa a adequação do uso do ambiente às aspirações sociais e/ou 

governamentais. 

Torna-se premente a inclusão da questão ambiental como parte integrante 

do planejamento de empreendimentos de infraestrutura rodoviária, especialmente na 

alocação de recursos orçamentários, uma vez que na fase de execução destas obras 

já se configura como crime ambiental a ausência de licenciamento (Lei 9605/98 – Lei 

de crimes ambientais). 

Esta preocupação deve ter início na fase de elaboração do projeto, quando 

é definida a proposta de alternativa de traçado a ser estudada. Enquanto que há até 

duas décadas atrás, os projetos de rodovias consideravam somente os aspectos 

geométricos e geotécnicos, atualmente a abordagem ambiental é exigida pela 

legislação e pela sociedade, além das constantes discussões nas audiências públicas 

sobre a definição da diretriz do traçado rodoviário. 

Os empreendimentos do setor de transporte, como as implantações e 

pavimentações de rodovias são consideradas atividades causadoras de impacto 

ambiental de acordo com a Resolução CONAMA 001/86, que dispõe sobre critérios da 

Avaliação de Impacto Ambiental, posteriormente modificada pela Resolução 

CONAMA 237/97. Nesta Resolução o artigo segundo estabelece a necessidade de 

elaboração de Estudo de Impacto Ambiental – EIA e respectivo Relatório de Impacto 

do Meio Ambiente – RIMA, para uma série de atividades, onde se destaca o inciso “I – 

Estradas de Rodagem com duas ou mais faixas de rolamento”, tendo como exigências 

no seu escopo a definição da Área de Influência Direta e Indireta com apresentação 

de estudo de alternativas de traçado. 

A partir do conhecimento preliminar do empreendimento e de sua região de 

inserção, são identificadas as questões ambientais mais importantes que poderão 

envolver o empreendimento, representados pelos impactos ambientais flagrantes.  
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Por intermédio desse conhecimento, são definidos e justificados os limites 

das áreas de estudo, demarcando-se as áreas de influência direta – AID e áreas de 

influência indireta – AII dos impactos da implantação e operação do trecho projetado. 

Essa delimitação é feita de acordo com as especificidades das condicionantes 

ambientais estudadas nos meios físico, biótico e antrópico (socioeconômico e cultural) 

e considerando-se as áreas de intervenções das obras, identificando-se e analisando-

se o potencial de modificação do empreendimento sobre esses condicionantes, nas 

fases de planejamento/projeto, construção e operação. 

Estas áreas que interagem diretamente e indiretamente com as estruturas 

físicas da rodovia, sua faixa de domínio e as demais áreas que sofrem alterações 

geradas pelas mesmas, tem uma clara relação causal com as bacias hidrográficas, 

citadas em legislação CONAMA 001/86, porém na prática não observada no 

desenvolvimento de estudos ambientais e no auxílio a processos de decisão de 

alternativas de traçado (BRASIL, 1986). 

Em uma compilação das principais deficiências dos EIAs no Brasil, 

efetuada por equipe do Ministério Público Federal em 2004, Sanchez (2008a) relata a 

desconsideração da bacia hidrográfica na delimitação das áreas de influência, 

atividade esta realizada “sem alicerce nas características e vulnerabilidades dos 

ambientes naturais”, também se repetindo a constatação de ausência de proposição 

de alternativas de traçado. Outros autores acrescentam a ocorrência de falhas na 

qualidade dos estudos ambientais no Brasil em projetos diversos, tendo sido 

verificado que “a consideração de alternativas foi negligenciada” (AGRA FILHO, 1993 

apud SÁNCHEZ, 2008a), em alguns tipos de empreendimentos até há falta de 

menção a estudos de alternativas locacionais e tecnológicas. 

As dinâmicas de alteração do uso do solo, decorrentes da 

implantação/pavimentação de estradas modificam profundamente o uso do solo 

próximos dos divisores de bacias, local preferido para construção devido a menores 

custos. Nos EIA/RIMA as áreas de influência direta/indireta de estradas são faixas 

lineares ao redor do eixo da estrada, atualmente delimitadas por 5 km até 30 km 

sendo que na realidade os possíveis impactos podem estar muito além das áreas de 

influência. 

Dependendo da fragilidade do local, por exemplo, solos com forte potencial 

de erodilibilidade, o impacto associado às transformações de uso do solo podem ser 
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sentidos em trechos à jusante, muito distante das nascentes e além das áreas de 

influência definidas nos EIA/RIMA de rodovias.  

Dito de outra forma, os impactos associados a projetos rodoviários não são 

corretamente analisados com definição de faixas lineares ao redor do eixo como área 

de influência. 

Visando analisar com mais propriedade os impactos de rodovias sobre os 

recursos naturais foi proposta a inserção das bacias hidrográficas na análise da área 

de influência do empreendimento viário. 

 

1.2. Justificativa 

 

As obras do setor de transportes rodoviários como todas as atividades 

humanas, necessitam de suporte a tomadas de decisão, que garantam a 

sustentabilidade ambiental, ou seja, a garantia que futuras gerações possam usufruir 

dos benefícios que o meio ambiente nos proporciona no presente. 

O rigor da legislação juntamente com o crescimento da conscientização 

ambiental na sociedade, verificado nas audiências públicas e questionamentos tanto 

dos órgãos ambientais como das comunidades afetadas, juntamente às exigências 

das instituições financeiras nacionais e internacionais, conduz uma maior 

responsabilidade de estudos técnicos de avaliações de impactos ambientais bem 

fundamentados para obras viárias. 

Este trabalho aplicou a metodologia de avaliação de impacto ambiental que 

fez a inserção ambiental no planejamento de projetos rodoviários, através de 

ferramentas de auxílio ao processo decisório de fácil acesso. 

A escolha de melhor traçado para implantação e pavimentação de 

rodovias, com aplicação de recurso público, em atendimento à demanda das 

comunidades locais e regionais, dinamizadoras de desenvolvimento, é um desafio aos 

governantes, tendo em vista, a necessidade de atender aos critérios de engenharia 

civil, socioeconômicos e da viabilidade ambiental. Assim, a definição da melhor 

alternativa locacional depende da área em que provocará os impactos. 

Sánchez (2008a) considera a busca e comparação de alternativas de 

traçado um dos pilares da AIA, com papel fundamental na concepção de projetos 

ambientalmente menos agressivos. 
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Segundo o artigo 5º da Resolução CONAMA 001/86, "o estudo de impacto 

ambiental deverá definir os limites da área geográfica a ser direta ou indiretamente 

afetada pelos impactos, denominada área de influência do projeto, considerando, em 

todos os casos, a bacia hidrográfica no qual se localiza". 

A partir do conhecimento preliminar do empreendimento e de sua região de 

inserção, são identificadas as questões ambientais mais importantes que poderão 

envolver o empreendimento, representados pelos impactos ambientais flagrantes. 

Cabe aí a inserção do estudo da bacia hidrográfica afetada pela obra rodoviária como 

fator de decisão para o estudo de alternativas. 

Ainda no Art.º 5, inciso I da Resolução CONAMA 001/86 prevê-se que o 

EIA deve contemplar todas as alternativas de localização de projeto, estas devem ser 

elaboradas com base nas análises econômicas, técnica e ambiental 

Os projetos rodoviários no Brasil, em sua maioria são usados como ponta-

de-lança em programas de desenvolvimento (BELLIA e BIDONE,1993) devendo o 

planejamento ambiental prever a apropriação dos recursos com a perpetuação do 

potencial de geração do desenvolvimento, já tendo sido observado casos em estados 

do Brasil, de desastres ambientais na ocupação das áreas de expansão. 

  O uso de financiamentos internacionais, a exemplo do Banco Mundial, 

que estipulam condições para influenciar a decisão dos governantes com a 

incorporação de considerações ambientais no planejamento, ocorre em países em 

desenvolvimento, em especial no estado do Tocantins, onde já foram desenvolvidos o 

Projeto de Gerenciamento da Malha Viária, o Programa de Desenvolvimento Rural 

Sustentável – PDRS e encontra-se aprovado para início em 2011 o Programa de 

Desenvolvimento Regional Integrado Sustentável – PDRIS. 

A pavimentação de rodovias que propiciem o desenvolvimento em áreas 

potencialmente críticas ambientalmente e sob a ótica econômica conduz a uma 

reflexão da possível sinergia de impactos que advirão com conseqüências para o 

meio ambiente. Assim, considerando que a infraestrutura viária desempenha papel 

importante no desenvolvimento regional, com modificações no espaço territorial no 

âmbito das bacias propôs-se este estudo considerando os impactos advindos desta 

ocupação. 
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1.3. Objetivos 

 

O presente estudo foi proposto na medida em que em uma avaliação crítica 

dos estudos ambientais de rodovias foram verificadas deficiências na indicação da 

abrangência espacial dos impactos, ou seja, a área de influência do empreendimento, 

fator que contribui para a definição da melhor alternativa locacional.  

Colocou-se a questão: os limites das áreas de estudo, demarcando-se o 

sítio de incidência direta e indireta dos impactos da implantação e operação dos 

trechos rodoviários projetados considerando faixas de largura mínima a partir do eixo 

da rodovia são apropriados para orientar e dimensionar a avaliação dos impactos 

ambientais? 

A partir destas considerações foi levantada a hipótese: as bacias 

hidrográficas podem ser consideradas como a unidade geográfica para a avaliação 

dos impactos ambientais, compreendendo as dinâmicas de alteração do uso do solo, 

decorrentes da implantação/pavimentação de estradas. 

O objetivo principal desta dissertação é a demonstração que a inserção das 

bacias hidrográficas na avaliação de impactos ambientais de empreendimentos viários 

contribuirá para a tomada de decisão sobre melhor opção de traçado. 

Foi eleito como caso de estudo, a rodovia estadual TO-247 que deverá ser 

implantada e pavimentada visando a ligação da região central (capital – Palmas-TO) 

ao Jalapão, impactando uma região com diversas restrições ambientais, porém, com 

grande potencial turístico e agrícola, além dos benefícios sociais. 

 

1.4. Estrutura do texto 

 

A dissertação foi desenvolvida em sete capítulos. O primeiro capítulo 

apresenta a introdução para o tema da pesquisa, sendo descrito o seu objetivo e 

relevância. 

O segundo capítulo discorre sobre a revisão de literatura, percorrendo por 

experiências de trabalhos de pesquisa de diversos autores, em avaliação de impactos 

ambientais de projetos semelhantes de implantação / adequação na pavimentação 

rodoviária, buscando orientar o trabalho. 

O terceiro capítulo – Metodologia Desenvolvida traz uma abordagem 

descrevendo as atividades que foram desenvolvidas para comprovar a necessidade 
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de considerar os limites da bacia hidrográfica como área de influência do 

empreendimento na avaliação dos impactos. 

O capítulo quarto refere-se ao Caso de Estudo escolhido em que foi 

testada a hipótese apresentada, na situação da rodovia TO-247, para ligação das 

sedes municipais Lagoa do Tocantins e Mateiros. Neste capítulo foi efetuada a 

aplicação do modelo proposto onde são desenvolvidas todas as fases da metodologia 

da pesquisa, com as ferramentas propostas ao caso de estudo. 

A avaliação da pesquisa é apresentada no capítulo quinto, denominado 

Análise e Discussão dos Resultados. 

Finalmente, as conclusões e recomendações são discorridas no capítulo 

sexto que leva o mesmo título. 
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2. REVISÃO DE LITERATURA 

 
2.1 Transportes e Meio Ambiente: modal rodoviário 

 

O processo de ocupação da Região Amazônica como fronteira agrícola foi 

deflagrado a partir da década de 1970, através de programas de incentivo 

governamentais, marcado por ações ocorridas na década de 60 como a implantação 

da rodovia Belém/Brasília e a mudança da capital do país para Brasília pelo 

presidente Juscelino Kubschek. 

A Implantação de rodovias na Amazônia estruturou-se segundo a ótica de 

Investimentos em Regiões não Ocupadas, em cujos objetivos foram priorizados sua 

integração com as demais regiões do País, a colonização e a segurança nacional, 

segundo Araújo (2000) o modelo adotado de planejamento ocorreu sem qualquer 

análise interna sobre as demandas de ordem local e regional e segundo os interesses 

de oligarquias e grupos locais, sendo, também, influenciado por interesses externos, 

numa visão de “região provedora” de recursos naturais. 

A ocupação da Amazônia Legal se deu sem nenhuma preocupação 

ambiental, tendo sido deflagrada a mudança de postura governamental somente a 

partir de 1980, com a atividade estradas que têm atuado então, como dinamizadoras 

do desenvolvimento. Porém diversos autores têm comprovado a sua associação às 

atividades impactantes como o desmatamento que configura em uma modificação no 

uso do solo, necessária a implantação de cultivo agrícola, pecuária, extração de 

madeira (PEREZ, 2007). A mesma autora, concluiu que no estado do Rio Branco foi 

possível observar que o desmatamento acompanha as linhas das rodovias federais e 

estaduais implantadas. 

O sistema viário como fator de promoção do desenvolvimento 

socioeconômico é considerado vital também na expansão do turismo, Beni (1998) 

destaca a comprovação de que o uso de automóvel ou ônibus possibilita maior lazer, 

quando o homem moderno tem suas atividades cada vez mais relacionadas com o 

uso do automóvel. Neste sentido, as estradas turísticas devem ter critérios de traçado 

e construção bastante peculiares, denominados “corredor cênico” compreendendo 

fatores como ângulo e duração da visão dos usuários, vegetação, impacto visual. Esta 
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atividade, principalmente o ecoturismo depende não só da infraestrutura, como 

também da manutenção da qualidade ambiental na região. 

Fogliatti, Fillippo e Goudard (2002) afirmam que a integração entre 

transportes, desenvolvimento econômico, qualidade de vida e meio ambiente foi o 

paradigma do século XX, quando avaliada a qualidade de vida de um indivíduo a 

maioria entre os parâmetros como saúde, lazer, educação entre outros dependem de 

um bom sistema de transporte. A facilidade de mobilidade e acessibilidade a 

determinada região que as rodovias proporciona, determinam o desenvolvimento 

econômico desta, porém a cada  etapa, planejamento, projeto, construção e operação, 

associam-se impactos ambientais em maior ou menor grau. 

A incorporação de modelos como o logístico, que permite a avaliação de 

impactos ocasionados por forças indutoras de desenvolvimento, como a conversão 

para uso agrícola por custos de transportes e outros fatores foi estudada por Mendes, 

Carlos et al. [200-] no Pantanal, que recomendam “os modelos poderiam ser 

incorporados em um arcabouço institucional de planejamento, análise de cenários e 

avaliação de impactos à nível governamental.” 

A preocupação ambiental com as rodovias tem-se acentuado e cada vez 

mais recomendados estudos com vistas a melhoria da gestão territorial e a 

conservação dos recursos hídricos, a exemplo da dissertação realizada por Carneiro 

(2008) na região do Jalapão - TO, onde a pressão agrícola e o crescimento da 

atividade turística são fatores de demanda por infraestrutura viária. Neste trabalho, foi 

efetuada uma análise síntese dos passivos ambientais relacionados à faixa de 

domínio da rodovia estudada onde se destacaram aqueles relacionados aos solos e 

aos recursos hídricos, 49% devido à assoreamento e 12% à erosão. 

 

2.2  Avaliação de Impactos Ambientais 

 

A evolução das ciências ligadas ao meio ambiente e a crescente 

popularização do tema meio ambiente tem introduzido uma diversidade de conceitos 

sobre as terminologias em uso relacionadas às expressões poluição, impacto 

ambiental e avaliação, mesmo entre especialistas, colocando a necessidade de 

estabelecer uma base conceitual comum visando uma comunicação mais eficaz. 

Na legislação brasileira, meio ambiente é “o conjunto de condições, leis, 

influências e interações de ordem física, química e biológica, que permite, abriga e 
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rege a vida em todas as suas formas” (Lei Federal 6.938, de 31 de agosto de 1981, art 

3º, I). 

Em uma visão mais a abrangente Sánchez (2008a) define: 

 
Por um lado, ambiente é o meio de onde a sociedade extrai os recursos 
essenciais à sobrevivência e os recursos demandados pelo processo de 
desenvolvimento socioeconômico. (...) Por outro lado, o ambiente é também o 
meio de vida, de cuja integridade depende a manutenção de funções 
ecológicas essenciais à vida. Desse modo, emergiu o conceito de recurso 
ambiental, que se refere não mais somente à capacidade da natureza de 
fornecer recursos físicos, mas também de prover serviços e desempenhar 
funções de suporte à vida. 
 

O termo poluição traz a conotação negativa da introdução no meio 

ambiente de qualquer forma de matéria ou energia que possa afetar os organismos 

vivos, podendo-se correlacionar certas grandezas físicas ou parâmetros químicos ou 

físico-químicos para os quais podem ser estabelecidos valores de referência. A 

emissão de poluentes não abrange toda a dimensão da degradação ambiental 

causada pela atividade humana, sendo que foi introduzido o conceito de impacto 

ambiental para cobrir os demais processos. 

Na literatura técnica, são encontradas várias definições de impacto 

ambiental, de acordo com Sánchez (2008a) sintetiza em “alteração da qualidade 

ambiental que resulta da modificação de processos naturais ou sociais provocada por 

ação humana”. Muitas vezes é confundido com a sua causa, a exemplo de uma 

rodovia, que não é o impacto e sim a causa dos impactos ambientais. Outra forma 

bastante divulgada nos meios de comunicação é a sua associação somente a 

situações negativas, porém se é uma alteração provocada por ação humana, pode ser 

benéfica ou adversa. 

A avaliação de impacto ambiental – AIA, da tradução de environmental 

impact assessment, onde assessment é de origem latina de assentar, sinônimo de 

evaluation, o mesmo que avaliar, em espanhol evaluacion e segundo definição 

adotada pela International Association for Impact Assessment – IAA “é o processo de 

identificar as consequências futuras de uma ação presente ou proposta”. 

Outro enfoque é dado na definição em que a considera um instrumento de 

execução de política ambiental, constituído por um conjunto de procedimentos 

técnicos e administrativos, visando à realização da análise sistemática dos impactos 

ambientais da instalação ou ampliação de uma atividade e suas diversas alternativas, 
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com a finalidade de embasar as decisões quanto ao seu licenciamento (DE LUCA, 

2008a).  Tem por tarefa, apoiar o processo de tomada de decisões, especialmente no 

que se refere à seleção de alternativas de desenvolvimento da ação em estudo e a 

consideração de estratégias de gestão ambiental. 

Sanchez (2008) também, alerta que para cumprir a função de ferramenta 

eficiente de política pública, a avaliação de impacto ambiental precisa desempenhar 

quatro papéis: ajuda á tomada de decisão, auxílio à concepção de projeto e 

planejamento, instrumento de gestão e de negociação social. 

Foi destacado por Bellia et all. (2005) que a gestão ambiental de obras 

rodoviárias deve garantir a execução dos Estudos Prévios de Viabilidade Ambiental e 

dos Estudos de Impacto Ambientais ( EIA/RIMA e PBA) e o respeito ás normas e 

especificações aplicáveis. 

Os estudos prévios compreendem a elaboração de Avaliação Ambiental 

Estratégica que deve ser realizada durante a fase de concepção das obras e 

instalações e do estudo de alternativas técnicas locacionais. Nesta fase, apesar da 

sua importância, uma vez que são tomadas as decisões sobre o melhor traçado, que 

são apresentados à sociedade nas audiências públicas no conteúdo da elaboração do 

EIA/RIMA, verifica-se a existência de abordagens superficiais nos projetos de 

engenharia (BELLIA et all., 2005).   

Omena e Santos (2008) em análise de procedimentos da AIA da rodovia 

SE/100 Sul conclui que pairam questionamentos sobre a efetividade do processo de 

avaliação de impactos realizada, cuja principal fragilidade é a falta de análise 

sistêmica, “integrando e comparando os efeitos ambientais esperados do projeto e de 

cada uma de suas alternativas”, percebendo a necessidade de estudos que 

contemplem o projeto desde a sua concepção e que atue efetivamente como 

instrumento de gestão. Os Estudos de Impactos Ambientais e respectivos Relatórios 

de Impactos Ambientais são considerados o mais detalhado entre os estudos 

ambientais que são previstos na legislação vigente, constituindo-se em um 

instrumento importante de decisão no licenciamento, devendo ser apresentados na 

fase de planejamento da obra, porém, muitas vezes associado somente à obtenção 

da licença ambiental. 
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2.3  Impactos Ambientais de empreendimentos rodoviários 

 

A dinamização da economia regional é um impacto comum nas avaliações 

de impactos ambientais de projetos de implantação e pavimentação de rodovias, 

causando modificações no uso do solo devido à facilidade no escoamento da 

produção. Figura entre os impactos com classificação quanto à natureza positiva, e 

ocorrência indireta, sendo estabelecido na fase de operação da rodovia, considerado 

fator conclusivo motivador da realização do empreendimento (BELLIA E BIDONE, 

1993). 

Em análise dos padrões de modificação do uso do solo provocados pelo 

homem, que envolve uma complexidade de fatores, as rodovias no Pantanal foram 

expressas na relação causa-efeito por Mendes, Carlos B. et al. [200-] da seguinte 

forma: políticas públicas como construção de estradas e ferrovias provocando 

alterações no uso do solo resultando em efeitos sobre a bacia hidrográfica (unidade 

ambiental de planejamento).  

A partir do conhecimento preliminar do empreendimento e de sua região de 

inserção, são identificadas as questões ambientais mais importantes que poderão 

envolver o empreendimento, representados pelos impactos ambientais 

flagrantes.Dentre os impactos mais comuns da maioria dos empreendimentos 

rodoviários destacam-se os problemas que se referem ao meio físico (assoreamentos 

e erosões), associados à fase construtiva e a ocupação do solo nas áreas marginais 

provocado pelo fator de dinamização da economia regional, sendo os sedimentos, o 

mais significativo dos poluentes da água (GALLARDO, 2004). 

A necessidade de preparação de cartas de suscetibilidade a processos de 

dinâmica superficial que poderiam subsidiar os estudos de alternativas de traçado foi 

verificada por Gallardo (2004) em análise das práticas de gestão ambiental na 

construção da rodovia dos Imigrantes sendo uma contribuição para roteiros de 

elaboração de estudos ambientais de rodovias. 

O planejamento ambiental, por seu caráter preventivo, deve ser coerente 

com a base de recursos naturais e socioeconômicos, assim, a tomada de decisão no 

setor de transporte deve caminhar através do compartilhamento entre os propósitos e 

necessidades das agências de transportes e da população, conforme Lisboa (2002a), 

contemplando as fases de lançamento de alternativas do traçado, escopo da 
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avaliação dos impactos, medidas mitigadoras, até a escolha da alternativa de traçado 

a ser detalhada posteriormente. 

A análise e comparação de alternativas, no que se refere às obras lineares, 

onde se enquadram as rodovias, são muito complexas, envolvendo a necessidade de 

comparar, classificar ou hierarquizar impactos de características muito diferentes. 

 

2.3.1. Avaliação Ambiental Estratégica 
 

A avaliação de impactos ambientais é dividida em três estágios pelos 

autores Uzelac; Veljkovic (1995) citado por Lisboa (2002): Strategic Environmental 

Impact Assessment (SEIA)  ou Avaliação Ambiental Estratégica (AAE), Preliminary 

Environmental Impacto Assessment (PEIA) ou Avaliação de Impacto Ambiental 

Preliminar e  Detailed Environmental Impacto Assessment ou Avaliação Detalhada de 

Impacto Ambiental. A AAE é a mais abrangente análise espacial do quesito meio 

ambiente ocorrendo na fase inicial de planejamento do projeto, sendo que a Avaliação 

de Impacto Ambiental Preliminar representa a etapa de seleção do melhor traçado de 

uma rodovia a ser implantada. 

O que tem motivado a utilização da Avaliação Ambiental Estratégica – AAE 

no Brasil, mais recentemente que nos outros países são as limitações naturais do 

Estudo de Impacto Ambiental (EIA). Estes apresentam dificuldades em analisar com 

profundidade alternativas tecnológicas e de localização e “a avaliação de projetos é 

feita sem levar em conta boa parte dos impactos cumulativos ou sinergísticos, ou 

alguns dos mais importantes impactos indiretos” (Sánchez, 2008b). 

Para Sánchez (2008b) a avaliação ambiental estratégica (AAE) ocorre no 

âmbito de inciativas, geralmente governamentais, porém avalia impactos ambientais 

de políticas, planos e programas, indo além dos projetos individuais. 

Sadles e Verheem (1996) citado por  Sánchez (2008b) destacam que a 

AAE deve ser utilizada no processo decisório, adequando e equacionando a avaliação 

das conseqüências ambientais com o peso das considerações sociais e econômicas. 

Lisboa [200-b] considera a introdução da AAE e a Avaliação de Impacto 

Ambiental Preliminar fundamental para a garantia da qualidade da implantação de 

empreendimentos rodoviários, uma vez que a etapa de escolha da alternativa 

locacional de um projeto deve ser considerada uma das mais críticas e decisivas para 

o sucesso deste. 
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O conteúdo e qualidade da Avaliação Ambiental Estratégica é bastante 

discutida, sob a ótica da International Association for Impact Assessment foi proposto 

que “um processo de avaliação ambiental estratégica de boa qualidade informa os 

planejadores, os tomadores de decisão e o público afetado sobre a sustentabilidade 

das decisões estratégicas, facilita a busca da melhor alternativa e assegura um 

processo decisório democrático. Isto aumenta a credibilidade das decisões e conduz a 

avaliações de impacto ambiental de projetos mais baratas e mais rápidas.” (IAIA, 

2002.) Aos critérios de desempenho da IAIA o Banco Mundial (AHMED, MERCIER e 

VERHEEM, 2005) citado por Sánchez (2008b) acrescentou mais um: a AAE deve ser 

capaz de influenciar a tomada de decisão. 

 Já no campo da avaliação de impactos ambientais detalhadas, são citados 

nas orientações de documento produzido pelo Ibama (1995) diversas técnicas de 

apoio à realização dos estudos de impactos ambientais - EIA que são divididos por 

alguns autores em fases distintas: identificação dos impactos, previsão dos impactos e 

avaliação da importância dos impactos. 

Foram citados por Gallardo (2004) vários autores que citam a existência de 

métodos diversos para identificação dos impactos ambientais que são encontrados na 

literatura, cada qual com suas vantagens. Seguem alguns métodos citados: 

 check lists; 

 matrizes, adaptações da Matriz de Leopold; 

 redes de interação; 

 overlay; 

Fogliatti, Fillippo e Goudard (2004) acrescentam outros métodos, como os 

mais utilizados em empreendimentos viários, citando-se além dos listados 

anteriormente: Modelos de Simulação, Análise Multicritério, Sistemas Especialistas e 

Modelo Fuzzy. A autora destaca também o surgimento de métodos que objetivam 

quantificar, comparar e selecionar a melhor alternativa, bem como monitorar e 

determinar medidas mitigadoras como o Método de Batelle também citado por De 

Luca (2008), as Matrizes de Realização de Objetivos e as Folhas de Balanço. 

Para Sánchez (2008a) é na fase de previsão dos impactos que será 

estimada a intensidade dos impactos ambientais e fornecidos dados para a avaliação 

da importância dos impactos e prognosticar a situação futura do ambiente entre outras 

funções. A atividade de previsão de impactos se desenvolve através da escolha de 

indicadores, definição do método do trabalho ou modelo, calibração e validação do 
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método, aplicação e obtenção de resultados e finalmente análise e interpretação. São 

vários os indicadores utilizados, assim como a sua associação aos aspectos ou 

efeitos e aos impactos ambientais, por exemplo, ao aspecto ambiental carreamento de 

partículas sólidas o indicador seria volume de partículas por unidade de tempo. 

São encontrados na literatura diversos métodos para previsão dos 

impactos, entretanto, não existe um método padrão, sendo importante a avaliação das 

condições particulares de cada projeto para escolher um método ou integrar dois ou 

mais métodos. Sanches (2008a) destaca cinco grandes categorias de métodos 

preditivos: 

 Modelos Matemáticos, mais utilizados para fenômenos físicos, 

proporcionando a simulação de diferentes cenários, muito 

utilizado na análise de impactos na qualidade do ar; 

 Comparação e extrapolação, a partir de situações análogas, com 

múltiplas aplicações, como no caso de previsão do aumento da 

taxa de desmatamento atribuíveis aos novos projetos 

extrapolados de observações de rodovias, através da modelagem 

do desmatamento passado associado ás rodovias, montagem de 

cenários de situação futura e de um banco de dados 

georeferenciados e a extrapolação das tendências do passado.; 

 Experimentos de laboratório e de campo; 

 Simulações e Modelos análogos (físicos, digitais); 

 Julgamento de Especialistas, baseado na experiência de 

especialistas para emitirem estimativas sobre a probabilidade de 

ocorrência de impactos. 

Em estudo para elaboração dos mapas de risco de erosão na microbacia 

do ribeirão Itambi (SP) pertencente à bacia do Aguapeí, gerenciado pelo CBH-AP, 

Fujihara (2002) utilizou modelos derivados da Equação Universal de Perdas de Solos 

- EUPS ou USLE e como ferramentas os recursos do geoprocessamento, 

especificamente o SIG, que permitiu a simulação e análise de diversos cenários. 

Prever impactos no processo de avaliação traz certas incertezas que 

podem ser sanadas com o monitoramento e acompanhamento,quando podem ser 
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definidas medidas corretivas. Gallardo (2004) destaca a importância da etapa de 

acompanhamento ambiental cuja ausência levaria a afirmar que seguramente 

impactos significativos não seriam minimizados, medidas apropriadas para redução de 

impactos não seriam detalhadas e ações e impactos não-previstos não seriam 

verificados. 

A escolha dos múltiplos critérios de avaliação da importância dos impactos 

encontrados na literatura leva aos diversos tipos de classificação, sendo fundamental 

a magnitude ou intensidade, bem como atributos citados na Resolução CONAMA nº 

01/86 – impactos diretos ou indiretos, benéficos ou adversos, imediatos, a médio ou 

longo prazo, temporários ou permanentes, reversíveis ou irreversíveis e outros 

variados que, conforme Sánchez (2008a), podem ser organizados por métodos de 

agregação, seja por Combinação de Atributos, Ponderação de Atributos – exemplo 

Método de Batelle e Análise por Critérios Múltiplos. 

Consta na Instrução de Serviço Ambiental - ISA-06 do DNER (1996), atual 

DNIT, quadro de identificação de impactos significativos da fase de projeto citando 

“erosões/assoreamento...”, associada a prováveis causa as “alterações no uso do solo 

das bacias de contribuição” entre outras, apresentando como recomendações e/ou 

medidas mitigadoras o “detalhamento geotecnológico de cada bacia e o 

estabelecimento de prognóstico do uso do solo das bacias de contribuição”. Estes 

impactos permanecerão na fase de operação das rodovias causados pela ocupação 

das respectivas áreas de influência e deverão ser monitorados. Assim, as medidas 

recomendadas devem contribuir para a tomada de decisão sobre a alternativa de 

traçado mais adequada juntamente com outros parâmetros de relevância ambiental, 

de engenharia e sócio-econômicas. 

 

2.3.2 Áreas de Influência de Empreendimentos Rodoviários 

 

Bellia e Bidone (1993) alertam que a distribuição dos impactos das rodovias 

tem características muito mais amplas do que os impactos dos outros meios de 

transporte, recomendando faixas de 30 a 100km para área de influência indireta, de 

acordo com a sua função, seja vicinal, alimentadora ou troncal. Ainda destacam que 

os impactos para área de influência direta envolve no mínimo a faixa de domínio da 

estrada e as microbacias de drenagem, até 1,5 - 2km de afastamento do eixo. 
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Lisboa (2002) concluiu em sua tese que “as áreas lindeiras às rodovias 

sofrem grande pressão de ocupação, daí a importância da decisão quanto ao tipo de 

área mais favorável para a futura rodovia atravessar”. 

No estado do Tocantins considerado como Área de Fronteira Econômica, 

Bellia e Bidone (1993) consideraram que em uma classificação que leva em conta que 

os impactos ambientais de uma rodovia, estes são refletidos principalmente na área 

de influência indireta, preconizando como área crítica de riscos potenciais do ponto de 

vista ambiental e socioeconômico. 

Em estudo realizado no estado do Acre, Amazônia Legal, Perez (2007) 

analisando o desenvolvimento do desmatamento em dois municípios, concluiu que as 

vias de acesso são um facilitador do processo de desmatamento, verificou também 

que o desmatamento segue as linhas das rodovias e em um dos casos no formato de 

espinha de peixe.  A mesma autora acrescenta que 80% da área desmatada do 

município de Rio Branco estão a no máximo 1000m da rodovia, porém a pesquisa foi 

limitada somente a faixas de 500 e 1000m quanto ao desmatamento. 

Através de técnicas de regressão logística Mendes, Carlos B, et al. [200-] 

elaborou cenários futuros para ordenamento de mudanças do uso do solo para uma 

ferrovia, empreendimento linear que como as rodovias, geralmente tema a área de 

influência direta definida em faixas lineares ao longo do eixo principal, apresentando 

inovações com a apresentação de cenário mais realista. No trabalho “a premissa 

básica utilizada é que a bacia hidrográfica surge como unidade ambiental de 

planejamento mais apropriada, pois recebe diretamente todos os impactos 

decorrentes de alterações de uso do solo...”. Destaca-se ainda que  o efeito é maior 

quando for associado às partes altas das bacias, locais preferenciais de construção 

das rodovias, os divisores de águas, pois a bacia é considerada um mecanismo de 

transporte de problemas de montante a jusante. 

Em estudos de impactos ambientais de rodovias mais recentes predomina 

a prática de indicação da área de influência indireta em forma de faixa linear na 

margem esquerda e direita do eixo da estrada, cita-se os casos das rodovias federais: 

BR-163/PA e BR-230/PA – faixa de 2 km para AID e 50 km para AII no caso do meio 

físico e biótico, para as atividades humanas foram considerados os municípios 

interceptados, as zonas de produção de soja e o município de Santarém; BR-010/TO 

– faixa de 5 km, incluindo as áreas de apoio para AID e os municípios resultantes da 

sobreposição das bacias hidrográficas e os municípios interceptados para AII; BR-
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242/TO – municípios interceptados para AID e ; BR-235/TO – faixa de 2,5 km para 

AID e faixa de 5km para AII nos meios físico e bióticos, no caso do meio antrópico os 

municípios interceptados ; Duplicação da BR-153/GO – 2 km para o meio físico e 3km 

para o meio biótico e socioeconômico para AID, e os limites dos municípios 

interceptados para o meio físico acrescidos dos municípios com limites próximos às 

rodovias para AII; na BR-381/MG – 2km para AID, 5km de AII para o meio biótico e os 

limites municipais daqueles interceptados para o meio antrópico., finalmente para o 

meio físico considerou “os limites das sub-bacias hidrográficas contíguas do 

empreendimento.”, único caso registrado. 

Assim, são muitos os questionamentos sobre os limites da área de 

influência das rodovias, comuns em Audiências Públicas ou outros fóruns de debate 

com participação popular, a exemplo do Relatório do Encontro BR-163 Sustentável 

(ISA et al., 2005), que mediante a identificação de problemas como a destruição de 

matas ciliares e impactos sócio-ambientais sobre o seu traçado e adjacências 

destacam a importância de preservar a integridade dos recursos hídricos e incorporar 

o conceito de “bacias hidrográficas como unidade de planejamento, como forma de 

suprir a necessária espacialização  da discussão em torno do desenvolvimento 

sustentável”. Foram incorporadas questões como a proteção das nascentes do rio 

Xingu, Araguaia e Teles Pires, sendo proposta a criação de Comitês de Bacias 

Hidrografias. 

 

2.3.3 Bacias como Unidade de Planejamento para AIA. 
 

No Brasil, a bacia hidrográfica é reconhecida como unidade territorial para 

implementação da Política Nacional de Recursos Hídricos e atuação do Sistema 

Nacional de Gerenciamento de Recursos hídricos, consiste num importante passo 

dado pela Lei 9.433/1997 uma vez que este recorte territorial possibilita a relação 

direta com as questões econômicas, sociais e ambientais da população que a integra 

(BRASIL, 1997). 

Lanna (1995), ao analisar a complexidade do gerenciamento de bacia 

hidrográfica, considera que deve dominar o conceito integrador do sistema como um 

todo para que a análise de cada parte da bacia faça sentido. O mesmo autor ressalta 

como vantagem desta consideração, “a rede de drenagem de uma bacia consiste num 
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dos caminhos preferenciais de boa parte das relações causa-efeito, particularmente 

aquelas que envolvem o meio hídrico". 

Consta na Instrução de Serviço Ambiental - ISA-06 do DNER (1996), atual 

Departamento Nacional de Infraestrutura de Transportes - DNIT, quadro de 

identificação de impactos significativos da fase de projeto citando 

“erosões/assoreamento...”, associada a prováveis causa as “alterações no uso do solo 

das bacias de contribuição” entre outras, apresentando como recomendações e/ou 

medidas mitigadoras o “detalhamento geotecnológico de cada bacia e o 

estabelecimento de prognóstico do uso do solo das bacias de contribuição”. Estes 

impactos permanecerão na fase de operação das rodovias causados pela ocupação 

das respectivas áreas de influência e deverão ser monitorados. Assim, as medidas 

recomendadas devem contribuir para a tomada de decisão sobre a alternativa de 

traçado mais adequada juntamente com outros parâmetros de relevância ambiental, 

de engenharia e sócio-econômicas.  

Mendes (2005)a em Relatório Final no Projeto Sistema de Apoio à Decisão 

– SAD para o Programa Nacional do Meio Ambiente – PNMA II, recomenda a “adoção 

de bacias hidrográficas como unidade de licenciamento ambiental”, efetuando em uma 

das etapas da análise dos processos ambientais em bacias o uso de modelagem de 

produção e transporte de sedimentos. A produção de sedimentos foi elaborada com 

base em modelo para estimativa de perda de solo, ou seja, a Equação Universal de 

Perdas de Solos (USLE – Universal Soil Loss Equation), de acordo com proposta de 

Wischmeier e Smith (1978). Ainda considerou-se a transferência de sedimentos em 

movimentação lateral, associando-se a USLE a uma taxa de transferência 

denominada de Relação de Distribuição de Sedimentos (SDR). 

De fato, a adoção da bacia hidrográfica como unidade de planejamento 

possibilita a integração de usos e a resolução de problemas que têm múltiplas causas 

e que extrapolam os limites administrativos municipais, como a poluição de um corpo 

hídrico, que tem entre suas causas o padrão de uso e ocupação do solo na área da 

bacia hidrográfica e em toda área de influência desta. 

Neste sentido, o conceito de Bacia Hidrográfica tem sido cada vez mais 

expandido e utilizado como unidade de gestão na área de planejamento ambiental. 

Tendo em vista que o seu conceito, quando aplicado a gestão das águas, estende as 

barreiras políticas tradicionais de planejamento e gerenciamento, desenvolvimento 

econômico e social em uma unidade física. 
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2.3.4 Equação Univesal da Perda de Solo e  SDR na avaliação de Bacias 
 

A aplicabilidade da USLE com uso de SIG para grandes áreas foi verificada 

por Farinasso et al.  (2006) em avaliação qualitativa do potencial de erosão na região 

do Alto Parnaíba, possibilidade que ocorre na fase de estudo de implantação de 

projetos rodoviários. 

A equação da perda de solo desenvolvida por Wischmeier e Smith (1978) 

exprime a ação dos principais fatores que influenciam a erosão pela chuva, 

atualmente, um dos modelos de predição de erosão hídrica mais utilizado a nível 

mundial, sendo expressa por: 

 

PCSLKRA    (1) 

A = perda de solo calculada por unidade de área, t/ha.ano; 

R = fator de erosividade da chuva e run-off , tm/ha.mm/h; 

K = fator de erodibilidade do solo, tmh/ha.mm; 

L = fator comprimento do declive (adimensional); 

S = fator grau do declive (adimensional); 

C = fator uso e manejo de culturas (adimensional); 

P = fator práticas conservacionistas (adimensional). 

Os fatores que afetam a perda de solo podem ser divididos entre aqueles 

que dependem de características naturais do meio físico (RKLS) e aqueles 

relacionados às formas de ocupação e uso do solo (CP). 

O fator de erosividade (R), conforme Bertoni e Lombardi Neto (1985) indica 

a capacidade da chuva de provocar erosão em uma área sem proteção e uma das 

maneiras de se expressá-la é através da somatória das médias mensais do índice de 

erosão (EI) calculado por Lombardi Neto e Moldenhauer (1992) citado por Fujihara 

(2002), como segue: 

 
759.02

823.89 







 

P
rEI     (2) 

Onde: 

EI = erosividade média mensal do mês i (MJ mm.ha-1 h-1); 
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r = precipitação média mensal do mês (mm); 

P = precipitação média anual (mm). 

O fator erodibilidade do solo (K) é a sua vulneralibildade à erosão, 

determinado por propriedades intrínsecas a ele, (a)velocidade de infiltração, 

permeabilidade e capacidade total de armazenamento de água; (b) resistência às 

forças de dispersão, salpico, abrasão e transporte pela chuva e escoamento. O seu 

valor é atribuído aos diferentes tipos de solo de ocorrência na região do estudo, 

expresso em tabelas de difícil elaboração efetuadas por Bertoni e Lombadi Neto 

(1985).  

Quanto aos fatores comprimento e grau de declive associados, referem ao 

fator topográfico (LS) que relaciona a intensidade de perdas esperadas de solo em 

função do comprimento de rampa e da declividade, segundo Wischmeier e Smith 

(1978) , sendo aplicada por Mendes (2005) através do Modelo Numérico do Terreno 

em SIG: 

 

 06505644165
1322

2 .sin,sin.
.







 

nxLS   (3) 

Onde:  

x = comprimento de rampa de escoamento; 

θ = declividade do terreno; 

n = 0.5 se θ ≥ 4.5% 

 0.4 se 3 ≤ θ < 4.5% 

0.3 se 1 ≤ θ<3% 

0.2 se θ ≤ 3% 

O fator cultivo e manejo do solo (C) tem sua base o mapa de uso dos solos, 

representa a razão entre as perdas de solo que ocorrem quando o este recebe uma 

dada cobertura e manejo, para as perdas que ocorrem quando o mesmo solo está 

descoberto. Foi estimado por Farinasso et al. (2006) o fator C através do nomograma 

segundo proposição de Wischmeier e Smith (1978). 

Para o fator P que é a razão das perdas de solo sob uma dada prática 

conservacionista, Bertoni e Lombardi Neto (1985) propõem uma tabela com valores 

de 0.2 a 1 para cultivos com uso de práticas conservacionistas ou não. 

Após a definição da equação USLE Mendes (2005), Usul (2002) 

associaram-na à taxa de transferência denominada de Relação de Distribuição de 
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Sedimentos (Sediment Delivery Ratio – SDR), proposto por Ferro e Minacapilli (1995) 

e Ferro (1997). Mendes cita que é possível “considerar a transferência de sedimentos  

de uma posição qualquer da bacia até o seu exutório[...]”, sendo a relação de aporte 

de sedimento é a razão entre a erosão total na bacia (A) e o aporte de sedimento(Y). 

A
YSDR    (4) 

 

Foi desenvolvida técnica de modelagem espacialmente distribuída 

utilizando SIG (FERRO e MINACAPILLI, 1995) através do conceito de tempo de 

deslocamento do escoamento para estimar a SDR, Ferro e Porto (2000) 

desenvolveram modelo de erosão espacialmente distribuído de remoção de 

sedimentos em uma bacia hidrográfica com base no conceito de tempo de 

deslocamento. 

 

 ii tSDR  exp  (5) 

 

Esta metodologia foi aplicada em bacias de pequenas dimensões, com 

tempos de concentração muito rápidos, sendo a escala de simulação da USLE anual, 

substituindo-se o ti por di. 

Para a obtenção do SDR, Miranda, Bastos e Tassi [200-] propôs a 

aplicação de três equações preconizadas anteriormente por Paiva (2003) porém 

observou grande variabilidade nos resultados ( 38, 39 e 50%) assim optou pela 

utilização de uma média dos valores: 

 
29804510 ,.,  ASDR  (6) 

22360330 ,.,  ASDR     (7) 

20

692

1
,

, 







A

SDR      (8) 

onde A é a área da bacia (Km2). 

Para obter a SDR na Bacia do rio Potiribu - RS Souza et al. [sem data] fez 

uso de duas equações abaixo descritas, tem-se a (Equação 9) e a (Equação 10) que é 
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dependente da declividade do canal. Também obteve valores muito variáveis para o 

SDR 0,2122 na equação (9) e 0,062 na (10). 

   
1250420 ,,  ASDR   (9) 

onde A é dado em milhas quadradas.  

 
40306270 ,, SLPSDR    (10) 

onde SLP é a declividade do canal principal. 

 

Assim, Mutua e Klik (2006) concluem que as estimativas de SDR que 

consideram somente a área como variável, mesmo recomendado no Manual da 

USDA não são adequados para grandes bacias, pois desconsideram fatores como 

uso e cobertura da terra, área da drenagem, declividade, comprimento da drenagem e 

propriedades dos solos. 

No que se refere ao transporte de sedimentos e aos riscos de 

assoreamento dos cursos d’água, Catellani, Targa e Batista (2005), em artigo técnico 

sobre a proximidade de estradas vicinais à rede de drenagem em Taubaté (SP), após 

verificar que a maior densidade de vias encontrava-se na faixa entre 0 e 100m, alertou 

sobre a necessidade das rodovias pavimentadas como as vicinais ter minimizado o 

cruzamento com os recursos hídricos e locadas preferencialmente nas linhas de 

cumeada ou zona de escoamento superficial. Porém não definiu critérios de 

afastamento das rodovias, a não ser pela Área de Preservação Permanente – APP, 

prevista no Código Florestal e legislação pertinente. 

Fujihara (2002) calculou o risco de erosão para uma bacia através de 

modelos derivados da Equação Universal de Perdas de Solos constatou que o índice 

de expectativa de erosão não é sensível a valores altos de Potencial Natural de 

Erosão – PNE. O PNE é expresso pelo produto do fator de erosividade da chuva (R), 

fator erodibilidade do solo (K) e fator topográfico (LS), não considerando os fatores de 

antrópicos. Os fatores antrópicos na USLE são o uso atual dos solos e a o fator de 

perdas de solo associados às práticas conservacionistas. O produto da USLE pelo 

uso potencial dos solos ou capacidade de uso do solo resulta em cenário futuro de 

produção de sedimentos. 
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A avaliação da capacidade de uso do solo é uma ferramenta técnica 

interpretativa no processo de planejamento e melhoramento dos sistemas produtivos. 

O uso potencial do solo classifica um grupo quantitativo de classes de solos sem 

considerar a localização e as esferas econômicas, políticas e sociais, considerando 

apenas as limitações permanentes dos solos quanto ao seu uso.  

 

2.3.5. Otimização de rotas 
  

Todo processo decisório, no contexto da avaliação de impactos ambientais 

demandam tentativas diversas de aplicação ou adaptação de ferramentas utilizadas 

em outras situações como a Análise por Critérios Múltiplos ou o uso de Sistemas de 

Informação Geográfica – SIGs. 

Lisboa (2002a) aplicou o método de auxílio à tomada de decisão 

denominado Método de Análise Hierárquica ao estudo de alternativa de traçado de um 

trecho do rodoanel Mário Covas, na região metropolitana de São Paulo, desenvolvido 

por Thomas L. Saaty, na Universidade da Pensylvania, em 1978. O modelo baseia-se 

em uma estruturação hierárquica dos objetivos, critérios/indicadores e alternativas 

consideradas no estudo, tendo sido considerado a participação da sociedade e as 

questões sócio-ambientais, exigindo a opinião de diversos atores.  

Sánchez (2008a p. 304 e 305) pondera que o formalismo matemático da 

aplicação da análise por critérios múltiplos na avaliação de impactos pode ser um dos 

fatores limitantes à sua aplicação. Este instrumento tenciona formalizar o processo 

decisório por meio de procedimentos de agregação das preferências dos tomadores 

de decisão. O mesmo autor cita: 
Para comparar seis alternativas de um projeto rodoviário na 

Holanda, Stolp et al. (2002) usaram quatro diferentes “perspectivas”: a 

“humana”, a “dos cidadãos”, a “ecológica” e a técnico-econômica”. A 

perspectiva humana foi desenvolvida a partir de documentos governamentais, 

que estabelecem políticas de qualidade de vida. A perspectiva dos cidadãos 

foi construída com a técnica de avaliação dos valores dos cidadãos. A 

perspectiva ecológica foi baseada no trabalho da equipe do EIA, assim, como 

a perspectiva técnico-econômica. Um procedimento simples de critérios 

múltiplos foi desenvolvido para comparar as alternativas sob essas quatro 

perspectivas. Quatro temas e dez subtemas tratados no EIA receberam pesos 

diferentes segundo cada perspectiva; a soma dos pesos de cada subitem é 

sempre igual a 1.(...) 
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Eastman et al. (1993) citado Weber et al. [200-] afirma que a escolha de 

uma determinada região a ser contemplada com a construção de uma estrada é de 

caráter político, mas a decisão sobre o melhor traçado e outras características tem 

caráter eminentemente técnico, contribuindo para a introdução de aspectos técnicos 

relevantes, porém é crescente a participação pública, como também o peso dos 

dirigentes dos órgãos públicos (prefeitos, secretário de estado, governador) na 

definição do traçado.  

Pilar  (2003) em sua tese sobre sistema de apoio a decisão para otimização 

de traçados de obras de engenharia civil, incorporou a análise além dos atritos de 

cunho ambiental e econômico, o atrito político, que no caso referia-se a anseios dos 

setores políticos e também de imobiliárias. 

Diversos autores utilizaram-se das ferramentas do geoprocessamento para 

definição de altenativa ótima, através do Idrisi, ArcGIS ArcInfo ou outros disponíveis, 

com a perspectiva de facilidade de uso  (COLLISCHON, 1999; PILAR, 2003; 

TAKAHASHI, 2004). 

 

2.4  Sistema de Informação Geográfica - SIG 

 

O SIG é uma ferramenta de grande potencialidade no planejamento de 

projetos e na avaliação de impactos, sendo utilizado na seleção de traçados de 

projetos lineares, cujo procedimento envolve a atribuição de importância às diferentes 

variáveis mapeadas. Os critérios de adoção dos pesos devem atender a diferentes 

interesses, sendo, portanto difícil obter a unanimidade na equipe de avaliação. Cowen 

(1988) define o SIG como “Um sistema de suporte à decisão que integra dados 

referenciados espacialmente num ambiente de respostas a problemas” 

A aplicação do procedimento depende de cinco itens, comenta Sánchez 

(2008a): a escala adotada, a acurácia das informações temáticas de cada quadrícula, 

a escolha dos temas e a escolha das classes dentro de cada tema, os pesos 

atribuídos a cada tema e classe e os critérios de combinação dos atributos. 

Através do uso de SIG e algoritmos de geoprocessamento, Paz e 

Collischonn (2008) derivaram a rede de drenagem da bacia do rio Uruguai, utilizando 

diferentes Modelos Numéricos do Terreno (MNT), considerando as ferramentas 

bastante ágeis na aplicação em bacias de grande porte. 
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Mendes e Cirilo (2001) destaca entre os exemplos de análise de 

informações espaciais, a integração do geoprocessamento com técnicas de 

otimização na definição de melhor traçado para construção de rodovias, como o 

Caminho de Mínimo Custo. 

O uso de Sistema de Informação Geográfica – SIG e modelos hidrológicos 

de forma integrada foi preconizado por Mendes e Cirilo (2001); Mendes (2005) com o 

uso de Modelo Numérico do Terreno - MNT, como citado: 
“todo processo de transferência (movimento) dos elementos do 

ciclo hidrológico, ao longo de bacias, está fundamentalmente baseado na 

utilização da topografia. O fluxo da água, sedimentos, poluentes, entre outros 

obedece às condicionantes topográficas como indicadores do caminho do 

movimento,(...)” 

 

A partir do MNT são derivados produtos relacionados a bacias 

hidrográficas, obtidos a partir de operação de filtragem do MNT original, declividade, 

curvatura no plano e no perfil, sombreamento de MNT, direção de escoamento e 

remoção de depressões, área acumulada, delimitação automática de sub-bacias, 

avaliação da rede de drenagem e índice de saturação (MENDES E CIRILO, 2001). 

Esta metodologia foi aplicada por Collischonn  e Pilar (2000)  para 

determinação de caminho de mínimo custo sobre um Modelo Numérico do Terreno 

(MNT), que pode ser utilizado para otimização do traçado de canal de irrigação, ou de 

um trecho de rodovia. 

Em notas de aula, Collischonn (2008) destacou que em ambiente vetor os 

problemas de caminhos de mínimo custo, vem sendo estudadas e resolvidos há 

bastante tempo pela Pesquisa Operacional, que elaborou as técnicas de Programação 

Dinâmica e Redes de Fluxo entre outros. Ainda destaca que o algoritmo para 

encontrar o caminho de mínimo custo em ambiente “raster” separam o problema em 

três partes: (i) geração de um plano de custo de passagem; (ii) cálculo de um plano de 

custo acumulado até o fim do caminho a partir de um plano de custo de passagem; e 

(iii) percorre o plano de custo acumulado de um ponto de início até o ponto final do 

caminho.  

Em uma avaliação para escolha do melhor traçado de uma linha de 

transmissão na África do Sul, Warner e Diab (2002) citado por Sánchez (2008a)  cita a 

utilização do SIG e apontaram como vantagem “a possibilidade de simular diversos 

cenários de variar os pesos, simulando a valoração que diferentes interessados 
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podem dar aos atributos considerados (temas ou subtemas).” Após a montagem da 

base de dados georreferenciadas e a preparação dos mapas para os vários temas, “o 

SIG permite simulações rápidas”. 

Foram utilizadas rotinas de apoio a decisão em SIG, do software IDRISI, 

em uma análise de alternativa de traçado de uma estrada no RS, Weber et al. [sem 

data], passando pela estruturação da base cartográfica digital, escolha dos critérios a 

serem utilizados para avaliação das alternativas, sendo eles ou de natureza técnica ou 

ambiental, sendo destacado como qualidade desta prática a agilidade e a visão não 

subjetiva do resultado. O critério ambiental eleito foi uso/cobertura atual do solo e 

como critérios técnicos foram utilizados os índices de rampa, largura e tortuosidade de 

cada trecho das estradas, distância total percorrida, sendo que a topografia regional e 

a geotecnia foram usadas como critérios finais de decisão.  

Costa et al. (2007) comparou o uso das imagens SRTM para delimitação e 

caracterização fisiográfica de uma micro-bacia verificando a vantagem na geração de 

dados do modelo numérico do terreno hidrologicamente consistentes e a viabilidade 

de extração de variáveis físicas das bacias hidrográficas em menor intervalo de 

tempo. 

A Embrapa Monitoramento por Satélite desenvolveu uma metodologia para 

gerar um novo produto de grande interesse para a sociedade brasileira. A base são os 

dados numéricos de relevo e da topografia do Brasil, obtidos pela nave espacial 

americana durante a missão conhecida como SRTM disponível no site da Embrapa. 

Estes dados apresentam resolução espacial de aproximadamente 90 m, originários da 

missão de mapeamento do relevo terrestre SRTM (Shuttle Radar Topography 

Mission), desenvolvido pela NASA (National Aeronautics and Space Administration) e 

NGA (National Geospatial-Intelligence Agency) dos Estados Unidos no ano 2000. 
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3. METODOLOGIA DESENVOLVIDA 

 

O estudo foi estruturado em torno das questões consideradas relevantes 

no auxílio à tomada de decisão em empreendimentos viários de modo a atingir os 

objetivos da avaliação de impactos ambientais, ou seja: assegurar que as 

considerações ambientais sejam explicitamente tratadas e incorporadas ao processo 

decisório; antecipar, evitar, minimizar ou compensar os efeitos negativos relevantes; 

proteger a produtividade e a capacidade dos sistemas naturais, assim como os 

processos ecológicos; e promover o desenvolvimento sustentável e otimizar o uso e 

as oportunidades de gestão de recursos (IAIA,1999 apud SÁNCHEZ, 2008a).  

A implantação de uma estrada, geralmente segue a orientação dos 

divisores de água. Estas rodovias induzem modificações no uso do solo nas regiões 

em desenvolvimento, podendo gerar processos erosivos que são observados através 

dos sedimentos carreados aos cursos d’água. Na maioria dos estudos ambientais 

estes impactos estão delimitados em faixas lineares – definidas como área de 

influência. 

Esta metodologia propôs rever a delimitação da área de influência de 

projetos rodoviários, considerando efetivamente as bacias hidrográficas impactadas, 

no sentido de incorporar a questão ambiental aos demais fatores que se apresentam 

na tomada de decisão sobre a otimização de traçados.  

A área de estudo foi delimitada considerando a ocupação potencial das 

bacias e as respectivas sub-bacias que podem vir a ser fatores de decisão na 

definição de traçado de um projeto de implantação e pavimentação de rodovia entre 

duas sedes municipais. 

A definição do caminho ótimo para a implantação de uma rodovia deve 

considerar os aspectos ambientais, construtivos e socioeconômicos, aspectos estes 

variáveis conforme as expectativas dos diversos atores no processo de decisão sobre 

a melhor rota para uma rodovia. Entre os tomadores de decisão estão políticos, 

técnicos e a comunidade seja ela a beneficiária ou a impactada, que devem ter 

atendidas suas  expectativas. 

Os critérios e indicadores a serem avaliados são diversificados, envolvendo 

aspectos mensuráveis e outros mais subjetivos. Os impactos sobre os fatores 

ambientais solo e água da bacia são quantificados, através da inserção de temas de 
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restrição, com destaque para a previsão de produção e arraste de sedimentos nas 

bacias, para se fazer um prognóstico futuro da melhor alternativa de traçado para a 

rodovia ou o traçado mais otimizado. 

Através do uso de ferramentas de Sistema de Informação Geográfica – SIG 

conhecidos como “caminhos de mínimo custo” ou least cost path os dilemas de 

decisão foram estruturados de acordo com cada uma das restrições ou atritos 

considerados relevantes na otimização de traçados rodoviários em regiões onde as 

estradas são indutoras de desenvolvimento. 

Baseando-se na análise de um estudo de caso foi desenvolvida a pesquisa 

e a tentativa de comprovação da hipótese. 

A proposta metodológica para execução deste trabalho é composta pelas 

seguintes fases: 

i. Escolha dos pontos de ligação – duas sedes municipais – decisão 

política; 

ii. Delimitação das bacias hidrográficas que poderão ser impactadas 

pelo empreendimento viário – área do estudo; 

iii. Aquisição dos dados analógicos e digitais para consubstanciar o 

trabalho e definição dos critérios e restrições a serem considerados 

na avaliação e níveis de classificação; 

iv. Aplicação do modelo matemático USLE – Equação Universal da 

Perda de Solos na quantificação das perdas de solo por bacias e a 

sua taxa de transferência - SDR; 

v. Pré-processamento e análise dos mapas de atrito por aspecto 

ambiental, construtivo e socioeconômico; 

vi.  Aplicação da metodologia de caminho de mínimo custo, com 

simulação visual do melhor traçado para a obra rodoviária; 

vii. Análise e discussão do traçado resultante da rodovia e definição da 

área de influência - AI. 

 

Para melhor visualizar a proposta metodológica, segue abaixo fluxograma 

ilustrado na Figura 1. 
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Figura 1. Fluxograma da metodologia. 
Fonte: Dados da pesquisa, 2010. 
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3.1 Definição da área de estudo 

 

A escolha de dois pontos a serem interligados, podem ser duas sedes 

municipais, dois pontos turísticos ou até mesmo duas rodovias pavimentadas são 

decisões políticas. 

A área de estudo foi definida como as bacias em que estão inseridos os 

pontos a serem interligados (origem e destino). 

O conhecimento da área de influência foi inicialmente delineado nesta 

etapa, através da definição da área de estudo considerando então a inserção da bacia 

hidrográfica. Conforme a escala trabalhada, foi necessária a divisão das bacias em 

sub-bacias, uma vez que estas possibilitam uma precisão maior. A escala de trabalho 

é definida pelo porte do empreendimento. 

Estas áreas sofrerão os impactos advindos da construção da rodovia, 

diretamente pelas atividades de implantação e readequação, acrescidas das áreas de 

apoio, canteiro de obras, empréstimos laterais, caminhos de serviço e jazidas, assim 

como as indiretamente afetadas através da dinamização do desenvolvimento regional, 

pela modificação do uso do solo. A pavimentação de rodovias atua como força motriz 

de modificação do uso do solo, associada a fatores agroclimáticos é indutora de 

desenvolvimento e à conversão para uso agrícola (MENDES et al., [200-]). 

 

3.2  Aquisição de dados 

 

Nesta fase foram levantados os dados existentes que se relacionam com o 

caso de estudo, situação em que se insere a proposta do empreendimento viário. 

Como a proposta deste estudo se insere na fase de planejamento, quando 

o projeto da rodovia ainda está sendo definido e os estudos ambientais ainda não 

foram realizados, foi efetuada atividade de coleta de dados de campo. Nesta etapa 

foram feitos levantamentos das características ou particularidades ambientais 

relevantes da área  possível de inserção da rodovia, de modo a caracterizar o cenário 

atual quanto aos meios físico, biótico e socioeconômico e avaliar antecipadamente as 

conseqüências do projeto, denominada por Donnelly; Dalal-Clayton; Hughes (1998) 

citado por Lisboa (2002) como Strategic Enviromental Impact Assessment (SEIA), ou 

Avaliação Estratégica de Impactos Ambientais. 

(i) Levantamento de dados de campo e dados secundários. 
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No levantamento de campo foram cadastrados com coordenadas 

geográficas de localização as sedes municipais a serem interligadas, os pontos de 

interesse turístico existentes e potenciais, atividades econômicas em 

desenvolvimento, as captações de água para abastecimento humano, os curso d’água 

a serem interceptados enfim, todos aquelas que poderão contribuir para o 

conhecimento do potencial de desenvolvimento e as definições dos critérios e 

parâmetros do estudo. As áreas com restrição legal, como unidades de conservação 

nas esferas municipais, estadual e federal, Terra Indígena, Reservas Legal averbadas 

e outras áreas de interesse ecológico, porventura existente também são cadastradas 

com localização e informações pertinentes. São efetuados reconhecimento e trilhas 

com posicionamento geográfico das estradas existentes com possível aproveitamento 

e adequação de traçado geométrico para a concretização do projeto rodoviário, bem 

como obras de arte (pontes e galerias) porventura construídas com aproveitamento na 

pavimentação da rodovia. 

Para o levantamento de campo utilizam-se os equipamentos que seguem: 

aparelho receptor GPS (Global Positioning System) de navegação, máquina 

fotográfica digital e notebook. 

Foram utilizados dados temáticos georeferenciados disponíveis 

gratuitamente no site da Secretaria de Planejamento e Meio Ambiente do Estado do 

Tocantins – TOCANTINS (2008) e no Departamento de Estradas de Rodagem do 

Estado do Tocantins (TOCANTINS, 2009). 

Utilizou-se as imagens SRTM para obtenção de dados topográficos, 

obtidas em site da Embrapa.  

A sub-bacias que compõem a área de estudo foram obtidas na base de 

dados do SEPLAN (TOCANTINS, 2008). 

A disponibilização de dados digitais como seguem descritos é de utilidade 

para a entrada e parametrização no uso da ferramenta proposta: 

 Dados de precipitação média mensal e anual, de postos pluviométricos que 

atendem as bacias interceptadas, obtidos junto ao sistema HidroWeb do site da 

Agência Nacional de Águas; 

 Mapa de cobertura e uso da terra (TOCANTINS, 2008); 

 Mapa de potencialidade de uso da terra (TOCANTINS, 2008); 

 Mapas de solos (TOCANTINS, 2008); 
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 Mapa de declividade (TOCANTINS, 2008); 

 Mapa de unidades de conservação e áreas protegidas (TOCANTINS, 2008); 

 Mapa de hidrografia (TOCANTINS, 2008); 

 Mapa de sub-bacias (TOCANTINS, 2008) 

 Mapa rodoviário (DERTINS, 2008); 

 Imagem orbital do Sensor a bordo do satélite CBER 2, com características: 

resolução espectral 8 bits, resolução espacial 20 m, ano 2005, disponível no 

site do Naturatins (2009); 

 Imagem SRTM (Shuttle Radar Topography Mission) no formato: GEOTIFF (16 

bits), resolução espacial de 90 metros, Sistema de Coordenadas Geográfica,   

datum: WGS-84, disponível no site da Embrapa (MIRANDA, 2005); 

 Dados cadastrais de órgãos públicos correlacionados e diagnósticos resultados 

de consultorias. 

 

3.3 Pré-processamento e análise de dados 
 

3.3.1. Critérios, restrições e grau de penalização 
 

O uso de sensoriamento remoto combinando SIG com algoritmos em 

ambiente raster já foi utilizado por diversos autores, na definição de caminhos ótimos, 

apresenta como vantagem a combinação de uma variedade de temas e informações.  

Os critérios relevantes à definição do traçado de uma rodovia foram 

divididos em três: (1) aspectos ambientais, (2) aspectos construtivos e (3) aspectos 

socioeconômicos, conforme experiência própria da pesquisadora e consultas a 

técnicos especializados da área rodoviária e ambiental e outros tomadores de 

decisão. Estes por sua vez foram subdivididos em temas de restrição como segue: 

Quanto ao aspecto ambiental, buscando reduzir ou minimizar os impactos 

de acordo com sua vulnerabilidade propõe-se a elaboração de mapa de atrito 

considerando os temas que seguem: 

 Uso/cobertura do solo – diversas restrições que são 

impostas devido ao uso do solo como travessia de áreas 

com vegetação nativa que serão desmatadas, áreas 

urbanas que serão desapropriadas e população 

reassentada, áreas rurais antropizadas por pastagem, 
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cultivos com agricultura ou reflorestamento que  serão 

desapropriadas e suprimidas; 

 Unidades de conservação / áreas protegidas – de acordo 

com a categoria e restrições do Sistema Nacional de 

Unidades de Conservação da Natureza - SNUC e Sistema 

Estadual de Unidades de Conservação; e outras áreas 

protegidas previstas em lei como Terra Indígena, Corredores 

Ecológicos e Reserva Legal; 

 Bacias e sub-bacias - a produção e transporte de 

sedimentos em cada unidade hidrográfica – conforme 

relação de aporte de sedimentos – através da aplicação da 

Equação Universal de Perdas de Solo - USLE como 

proposto por Wischmeier and Smith (1978) e Relação de 

Aporte de Sedimentos; 

 APP - Nascentes – restrição à travessia de Área de 

Preservação Permanente do entorno das nascentes – APP 

de 50 m e zona tampão para proteção dos cursos d’água – 

traduz a preocupação com a proximidade de obras 

rodoviárias a cursos d’água, reduzindo assim o efeito do 

carreamento dos sedimentos  e a instalação de rodovias em 

áreas de mata ciliar, conforme legislação federal. 

 

Quanto ao aspecto construtivo, foram considerados fatores topográficos, 

dificuldade construtiva e operacional que afetam o desenvolvimento da rodovia: 

 Declividade – a rampa máxima ascendente ou descendente 

é definida conforme a classe da rodovia, portanto a 

declividade foi dividida em classes, sendo projetados níveis 

crescentes de atrito acima da declividade de rampa prevista 

na classe da rodovia; 

 Obras de arte correntes ou especiais – os cursos d’água são 

transpostos por pontes, bueiros celulares ou tubulares, 

dimensionados conforme estudo hidrológico. É verificado 

que quanto maior o porte dos cursos d’água maior a 
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dificuldade na execução das obras de travessia. Neste tema 

foram adotadas níveis de restrição conforme área de 

formação de drenagem da bacia (TOCANTINS, 1994); 

 

Quanto aos aspectos socioeconômicos: atendimento a questões políticas 

e/ou sociais relacionadas à apoiar projetos governamentais ou privados em 

desenvolvimento ou pequenas comunidades específicas. 

 Pontos turísticos que serão beneficiados com a implantação 

da rodovia – o objetivo é aproximar a rodovia aos pontos de 

relevância para o projeto, visando desenvolver a região, 

podendo ter motivações diversas em outras situações; 

 

Para definição do grau de penalização foi adotada uma escala de 1 a 10, 

com situação mais conveniente, pontuação 1 e situação menos conveniente 10, 

conforme proposto por Pilar (2002) em desenvolvimento de sistema de apoio a 

decisão de traçados em obras de engenharia civil, exposto no gráfico 01.  

Foi definida a pontuação 1000 para barreira absoluta de restrição, áreas 

que tem a passagem vedada para implantação da rodovia. Weber e Hasenack (1998) 

definiram o custo de passagem para gasoduto ligando as cidades de Sinimbu e Barros 

Cassal (RS) e utilizaram 1000 para restrição máxima. 

Gráfico 01. Associação dos temas de restrição ao grau de atrito. 
Fonte: Pilar (2002). 
 

GRÁFICO DE ATRITO 
PESO / 

GRAU DE ATRITO 

TEMA DE RESTRIÇÃO 

1 

10 
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A proposta aplicada no estudo para os níveis de restrição em cada tema 

seguiram os graus de penalização conforme apresentado tabela 1. 

TABELA 1.  
Níveis de restrição à pavimentação da rodovia e respectivos graus de 

penalização. 
 

Nível de restrição Grau de penalização 

Nenhum 1 

Baixo 2 e 3 

Médio 4 e 5 

Alto 6 e 7 

Muito Alto 8 e 9 

Excessivo 10 

Barreira Absoluta 1000 
    Fonte: Pilar, 2002 e Weber e Hasenack, 1998. 

 

3.3.2. Preparação dos mapas de atrito 
 

Para cada tema de restrição foi produzido um mapa de atrito em formato 

raster. A preparação dos dados para uso no modelo segue as operações abaixo: 

 Análise de consistência dos dados pontuais (hidrológicos e 

climatológicos); 

 Conversão de coordenadas geográficas (LAT/LONG) para 

planas (UTM) e uniformização da base cartográfica utilizando 

projeção UTM e DATUM South American 1969 – SAD 69; 

 Utilização dos mapas de uso do solo, declividade, unidades 

de conservação e áreas protegidas, hidrografia, sub-bacias, e 

pedologia (TOCANTINS, 2008), além de rodovias (DERTINS, 

2008); 

 

Seguem-se as operações em Sistema de Informação Geográfica – SIG que 

harmonizaram e organizaram os dados para a simulação ambiental: 

 Processamento em Modelo Numérico do Terreno – MNT; 

 Preenchimento das depressões; 

 Sobreposição e reclassificação de mapas; 
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 Calculadora de mapas. 

 

O tamanho do pixel padronizado foi 10mx10m considerando as restrições 

que foram colocadas. Porém, com o uso de imagens SRTM o pixel está definido em 

90mx90m.  

 

ASPECTOS AMBIENTAIS 

   

(i) Mapa de atrito para uso do solo 

Através do mapa de uso do solo, foi elaborado o mapa de atrito do uso do 

solo. Inicialmente foi efetuada a reclassificação com agrupamento dos indicadores de 

uso do solo em usos com semelhança de restrição. Seguiu-se a operação de 

reclassificação. É preferível que os traçados projetados desenvolvam-se sobre áreas 

desocupadas, evitando desapropriações de residências e reassentamento das 

famílias. Foram atribuídas penalizações crescentes para a cobertura vegetal, 

conforme adensamento por tipologia. 

 

(ii) Mapa de atrito de unidades de conservação / áreas protegidas 

A travessia em nível de unidades de conservação – UC deve ser 

minimizada, visando reduzir os impactos sobre a fauna e flora. A operação do ArcGIS 

ArcInfo de reclassificação foi utilizada no mapa de unidades de conservação. O 

Sistema Estadual de Unidades de Conservação da Natureza - SEUC – instituído pela 

Lei estadual 1560/2005 e o Sistema Nacional de Unidades de Conservação da 

Natureza – SNUC – instituído pela Lei federal Nº 9985/2000  prevêm a restrição de 

uso, dividindo as UC’s em dois grupos: Unidades em Proteção Integral e Unidades de 

Uso Sustentável. 

No primeiro estão inseridas a Estação Ecológica, Parques, Monumento 

Natural, Reserva Biológica e Refúgio de Vida Silvestre. No grupo das unidades de uso 

sustentável estão as categorias Área de Proteção Ambiental – APA, Área de 

Relevante Interesse Ecológico - ARIE, Floresta Nacional, Reserva Extrativista, 

Reserva de Fauna, Reserva de Desenvolvimento Sustentável, Reserva Particular do 

Patrimônio Natural – RPPN, Rio Cênico e Estrada Parque. 

As Unidades de Conservação, exceto APA e RPPN, ainda possuem zona 

de amortecimento das áreas, conforme previsto na Lei 9.985/2000 – SNUC, acrescida 
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da restrição a atividades que possam afetar a biota num raio de 10km de qualquer 

UC, sendo obrigatória a autorização do Instituto Chico Mendes da Conservação da 

Biodiversidade – ICMBio ou Naturatins, citado na Resolução CONAMA 13/1990. 

Ainda foram consideradas áreas protegidas as Terras Indígenas, de acordo 

com as restrições impostas pela legislação federal - Estatuto do Índio – Lei 6001/1973. 

Outras áreas como existência de Reserva Legal, também pode ser avaliada, porém 

não aplicado ao caso, pois não há interceptação desta categoria de área protegida. 

 

(iii) Mapa de atrito das APP’s de nascentes e zona tampão dos cursos 

d’água 

 

As Áreas de Preservação Permanente somente podem ser suprimidas em 

caso de utilidade pública, onde se enquadram as rodovias. As APP’s das nascentes 

são definidas e protegidas conforme legislação federal Lei 4.771/65 que instituiu o 

Código Florestal e a Resolução CONAMA 303/2002. 

Assim, considerando estudos anteriores que comprovam o nível alto de 

impactos de rodovias nas nascentes (GALLARDO, 2004) neste trabalho foi vedada a 

passagem nestas áreas. O procedimento adotado compreendeu o uso do mapa de 

hidrografia (TOCANTINS, 2008), inicialmente com a marcação de todas as prováveis 

nascentes e a marcação de um buffer de 50m, considerada área da APP das 

nascentes. Prosseguiu-se com a adoção de buffer de 100mm para zona tampão ideal 

para instalação das rodovias. 

Foi verificado em simulações em SIG para eficiência de diferentes larguras 

de mata ripária na retenção de escoamentos superficiais, por Simões (2001), que o 

afastamento de 100m dos cursos d’água para zona tampão alcançou eficiência 

máxima de 90,18%, para picos de escoamento nas condições mais críticas na área 

estudada. Apesar da recomendação do Código Florestal de largura mínima de 30 m 

para cursos d’água de até 10m, a eficiência foi 32,40% nas mesmas condições. 

Sendo que a partir de um ponto os ganhos em eficiência não correspondem ao 

incremento da largura, verificado também para redução de sedimentos por McKaguem 

et al. (1996) citado por Simões (2001). Assim, propôs-se a marcação de buffer de 

100m nos cursos d’água e a restrição excessiva para implantação de projetos 

rodoviários nesta área. 
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(iv) Mapa de atrito das sub-bacias 

Dentre os aspectos ambientais foi avaliada a produção e arraste de 

sedimentos que se optou pela abordagem em um subitem específico, considerado o 

aspecto principal da pesquisa. 

 

ASPECTOS CONSTRUTIVOS 

 

(v) Mapa de atrito de obras de arte 

 

A transposição de cursos d’água é prevista em projeto através de obras de 

arte especiais (pontes) ou obras de arte correntes (galerias e bueiros) considerada 

como fator de restrição ao desenvolvimento construtivo da obra rodoviária. Este 

indicador foi medido através do porte, pois quanto maior o curso d’água, maior ou 

mais complexa a obra de arte. 

Para o dimensionamento das obras de arte nas drenagens, obtêm-se as 

vazões aplicando diferentes metodologias de acordo com a área de contribuição,  

associando-se a área de contribuição das bacias, classificadas conforme Norma de 

Projeto – NP-03/92 do Dertins. Assim, pode-se prever que a dificuldade construtiva e 

o custo econômico são crescentes conforme a definição do tipo de obra de arte a ser 

implantada, apesar de variações específicas de cada situação. 

 

(vi) Mapa de atrito de gradiente de rampa 

 

O desenvolvimento construtivo de uma rodovia deve seguir a norma 

relacionada a rampa máxima a ser projetada, conforme a classe da rodovia. Uma vez 

definida a rampa máxima permitida 10%, o esforço construtivo foi avaliado através do 

mapa de declividade, em formato raster, definindo como nenhuma restrição 

construtiva as áreas com declividade igual ou inferior à permitida. A partir desta as 

classes e suas associações recebem valores crescentes de grau de penalização.  
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ASPECTO SOCIOECONÔMICO 

 

Associada à necessidade de ligar dois pontos, no caso duas sedes 

municipais foi considerado como importante para o desenvolvimento regional o 

incremento ao turismo.   

 
(vii) Mapa de atrito dos pontos turísticos 

 

A decisão sobre o melhor traçado para uma rodovia a ser pavimentada 

necessita incorporar vários anseios políticos ou socioeconômicos, seja do 

representante político ou da comunidade representada, que podem ser a aproximação 

com determinado projeto governamental ou privado, a aproximação de determinado 

povoado, vila ou vilarejo entre os pontos a serem interligados ou o atendimento a 

determinada micro-região por seu caráter produtivo instalado ou potencial econômico. 

A existência de infraestrutura foi descrita como fundamental para apoiar o 

desenvolvimento turístico, com destaque para o sistema viário como fator de 

promoção do desenvolvimento socioeconômico e expansão do turismo, Beni (1998). 

Neste estudo foi considerada a necessidade de aproximar a rodovia 

pavimentada do acesso aos pontos turísticos visando incrementar o turismo regional e 

a sua acessibilidade. 

 

3.4 Avaliação da geração e aporte de sedimentos nas sub-bacias 

 

Este tema de restrição está inserido na categoria relacionada ao Aspecto 

Ambiental, porém foi dada ênfase nesta parte da metodologia, pois traduz um 

indicador a ser incorporado nos estudos ambientais para a definição da área de 

influência de um projeto rodoviário a ser implantado. As características de quantidade 

e qualidade dos sedimentos transportados em uma sub-bacia hidrográfica representa 

a sua relevância quanto ao planejamento do seu aproveitamento ou viabilidade de 

implantação de uma rodovia incrementadora dos processos de ocupação do uso do 

solo, como projetos agropecuários ou florestais. 

Nesta etapa de simulação ambiental, foi testada uma estrutura de 

modelagem que integra o SIG e modelos para estimativa da perda de solos, dividida 

em: primeira fase – Balanço Vertical; posteriormente, a segunda fase denominada 
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Movimentação Lateral associada ao transporte de sedimentos se traduz na 

associação da USLE ao emprego de uma taxa de transferência denominada de 

Relações de Distribuição de Sedimentos - SDR. 

A equação da perda de solo desenvolvida por Wischmeier e Smith (1978) 

exprime a ação dos principais fatores que influenciam a erosão pela chuva, sendo 

expressa pela equação (1) e aplicada conforme as especificações das equações (2), 

(3) e (4), ambas citadas anteriormente. 

Este método de integração propõe a divisão da bacia hidrográfica em 

partes menores (células ou pixels) para o cálculo das propriedades físicas. “O 

conjunto de células estabelece a conexão entre as células, basendo-se no MNT. Uma 

linha de fluxo é estabelecida, escoada de célula para célula (MNT) e o hidrograma 

(e/ou carga de sedimentos) é calculado no exutório da bacia.” (MENDES, 2005a). 

Assim, uma vez produzida a carga de sedimentos por células, bem como a 

capacidade de transporte de cada célula a drenagem mais próxima, é possível avaliar 

cada sub-bacia da bacia principal. 

 

3.4.1 Estimativa da produção de sedimentos (balanço vertical) pela Equação 
Universal de Perdas de Solo – USLE 

 

Para determinar a estimativa da produção de sedimentos foi necessária a 

produção de arquivos em formato matriciais ou raster e aplicação do modelo 

paramétrico proposto abaixo descrito: 

1. Mapa de erosividade das chuvas; 

2. Mapa de erodibilidade dos solos; 

3. Mapa do fator topográfico – LS; 

4. Mapa de uso e manejo do solo. 

Seguindo a proposta de Fujihara (2002) foi calculado o Potencial Natural de 

Erosão – PNE que contempla os fatores dependentes das condições naturais: R, K e 

LS. 

O fator erosividade da chuva (R) foi determinado para cada posto ou 

estação pluviométrica, de acordo com Lombardi Neto e Moldenhauer (1992) citado por 

Fujihara (2002) na equação (2). 

Após a identificação dos postos ou estações pluviométricos nas 

proximidades da área de estudo no hidroweb do site da ANA, foi obtido cada fator R 
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através da aplicação da equação em planilha Excel, e obtenção do mapa de 

erosividade com a interpolação pelo inverso da distância dos pontos calculados, 

através da opção do ArcGIS ArcInfo:  Spatial Analyst – Interpolate to Raster – Inverse 

Distance Weighted. 

O fator erodibilidade do solo (K) que representa a resistência do solo à 

erosão, estimado por métodos indiretos, através do reagrupamento das classes e 

associações do mapa de pedologia (TOCANTINS, 2008) foi efetuada a reclassificação 

aplicando o fator de erodibilidade determinado em nomograma de Wischmeier (1971) 

citado por  Farinasso et al. (2006), ambas as operações foram feitas no ArcGIS 

ArcInfo, através da operação: Spatial Analyst – Reclassify. 

O fator topográfico (LS) afeta diretamente o desprendimento das partículas 

do solo, bem como o carreamento dos sedimentos, que estão correlacionados com o 

comprimento de rampa e declive, foi obtido através do uso das imagens SRTM 

extraídas do site da Embrapa Monitoramento por Satélite: 

http://www.relevobr.cnpm.embrapa.br/dowload/to/to.htm, articulação compatível para 

escala 1:250.000, utilizando ferramentas do ArcGIS ArcInfo. 

Os fatores relacionados à forma de ocupação C e P foram determinados, 

considerando um possível cenário futuro, ou seja, a rodovia indutora do 

desenvolvimento regional permitirá a ocupação das bacias e sub-bacias, conforme o 

potencial de uso do solo ou capacidade de uso previsto no Zoneamento Ecológico 

Econômico do Estado. 

O fator de cultivo e manejo do solo (C) é a relação esperada entre as 

perdas de solo de um terreno cultivado em dadas condições e as perdas 

correspondentes de um terreno descoberto e cultivado. Considerou-se, então, que a 

ocupação futura respeitará as indicações de potencial de uso da terra efetuado pelo 

Zoneamento Ecológico Econômico da SEPLAN. 

Assim, o fator C foi obtido considerando o cenário de ocupação, 

determinado através da reclassificação do mapa de Potencial de Uso da Terra 

(TOCANTINS, 2008), utilizando no ArcGIS a operação de Reclassificação a partir de 

valores compilados de diversos autores. 

 Para o fator práticas conservacionistas (P), relacionados aos métodos de 

conservação aplicados, foi utilizado o valor 1,0 que se refere à preparo e plantio morro 

abaixo, considerando que não serão adotadas práticas conservacionistas. 
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3.4.2 Aporte de Sedimentos (Movimentação Lateral) 
 

Nem todo sedimento produzido na Bacia efetivamente atinge a calha do rio, 

a SDR - Sediment Delivery Ratio ou “taxa de entrega de sedimentos” é a 

representação da quantidade de sedimentos produzidas que ficam retidas nas 

depressões, grotas, pré-encostas, vegetação ciliar entre outros locais. 

 

Segundo proposto por Ferro e Minacapilli (1995) e Ferro (1997) o SDRi 

corresponde a fração de produção de sedimentos para célula i, conforme a estrututra 

do banco de dados deste trabalho, foi definido como: 

 ii tSDR  exp   (5) 

Onde:  

β é um parâmetro que representa a morfologia da bacia, assumindo-se o 

valor igual a 1 (MUTUA E KLIK, 2006, JAIN, 2000); 

ti  é o tempo de deslocamento ao longo da linha de escoamento 

A. Obtenção do aporte de sedimentos com o uso do tempo de deslocamento como 

segue na equação (11). 





jM

m m

m
j V

lt
1

 (11) 

Para a estimativa da velocidade, a fórmula de Chézy, com coeficiente de 

Manning é a mais utilizada, tendo sido experimentada em canais de pequenas e 

grandes dimensões para projetos e obras construídas.  A aplicação da equação de 

Manning também é aplicável ao escoamento superficial verificado por Fleckenstein 

(1998) e Usul (2002). 

SRCV h  (12) 

Onde: 

C: coeficiente de Chézy; 

Rh: raio hidráulico (m); 

S: declividade (m/m). 

Manning propôs: 

n
RC h

6
1

   (13) 

Onde: n é o coeficiente de Manning 
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Substituindo a proposição de Manning na equação (12) temos: 

n
SRV h

2
1

3
2

.
  (14) 

Para o cálculo da matriz de velocidade em escoamento superficial, neste 

estudo todos os parâmetros (coeficiente de rugosidade n, Raio hidráulico Rh e 

declividade S) foram preparados na forma de matrizes em ambiente de ArcGis e 

inseridos na equação 14. 

A matriz do coeficiente de rugosidade de Manning depende da cobertura 

vegetal ou uso do solo da área de estudo de cada sub-bacia, com valores atribuídos 

para os tipos de uso do solo conforme tabela preparada para utilização na equação de 

Manning para escoamento superficial em terra e canal. 

O valor do raio hidráulico da bacia em canais abertos é calculado a partir 

da relação da área de fluxo e do perímetro molhado do canal, no caso de escoamento 

superficial não se formam canais de fluxo e são aceitas áreas terrestres de fluxo com 

largura determinada, com uma fina camada de fluxo considerada com profundidade 

de escoamento superficial de 1mm (0,001m) (USUL, 2002).  

Para as drenagens os valores de Raio hidráulico foram obtidos através da 

ferramenta FlowAccumlation do ArcGis do MNT. A partir do MNT da área, em estudo 

similar Fleckenstein (1998) utilizou os valores do raio hidráulico tabelados, em uma 

grade de 30 x 30 m, onde o número de células formando cursos d’água estão 

agrupados em 4 grupos de valores do fluxo acumulado, com um valor único de R para 

cada grupo. Já numa grade de 10 x 10 Usul (2002) considerou como ponto inicial  

1000 que representa uma área de drenagem a partir de 0,10 km2. 

 

B. Obtenção do SDR a partir da distância (d). 

Considerou-se também a proposta de aplicar a função de decaimento 

exponencial em função da distância. Verificado por Mendes (2005) que em bacias 

com pequenas dimensões e tempos de concentração muito rápidos, sendo a escala 

de simulação da USLE anual, propôs-se substituir o tempo de deslocamento (ti) pela 

distância de cada célula até a drenagem mais próxima (di) transformado de metro (m) 

para quilômetro (Km) . 

 ii dSDR  exp  (15) 
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De posse dos dados de produção de sedimentos de cada célula, assim 

como a capacidade de transporte por célula a drenagem mais próxima, é realizada a 

avaliação de cada sub-bacia do estudo com o uso do ArcGis. A relação existente 

entre perdas de solos de uma bacia (áreas-fonte) e a produção de sedimentos, 

medida no exutório dessa bacia é definida como Relação de Liberação de Sedimentos 

– SDR. 

Para se obter a quantidade de sedimentos que aporta o corpo d’água (Y) 

efetuou-se a multiplicação da Produção Total de Sedimentos por Sub-bacia (USLE) 

pela SDR, como descrito na equação 16. Assim, pela relação do valor quantitativo de 

sedimentos no exutório de cada bacia, procede-se a classificação de cada uma. 

Y = A.SDR (16) 

 

3.5 Aplicação do Caminho de Mínimo Custo 

 

Os algoritmos de caminho de mínimo custo separam o problema em duas 

partes (STEFANAKIS e KAVOURAS, 1995 apud WEBER e HASENAK, 1998): 1) 

calcular um plano de custo acumulado até o fim do caminho a partir de um plano de 

custo de passagem e 2) percorrer o plano de custo acumulado de um ponto de início 

até o ponto final do caminho. 

Para o obtenção do traçado de mínimo custo da rodovia, foram utilizados 

os mapas de atrito obtidos nas fases anteriores, relacionados aos aspectos 

ambientais, construtivos e socioeconômicos, em ambiente raster do ArcGis 

ArcInfo. 

A matriz de atrito ambiental considerou a média aritmética dos três temas 

propostos: Uso do Solo, Unidades de Conservação, Nascentes e Micro-bacias 

hidrográficas. 

 Seguiu-se a obtenção do mapa de atrito construtivo através da média 

aritmética dos dois temas apresentados, declividade (rampa) e obras de arte. 

O aspecto socioeconômico levou em consideração somente a ligação entre 

os dois municípios e a aproximação dos pontos turísticos, sendo efetuada diretamente 

a obtenção da matriz de custo e o caminho de mínimo custo. 
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4 CASO DE ESTUDO: RODOVIA TO-247, LIGAÇÃO ENTRE MATEIROS E 
LAGOA DO TOCANTINS. 

 
4.1 Caracterização geral da área estudada 

 

O estado do Tocantins está enquadrado na região Amazônica, a partir da 

incorporação de todas as áreas abaixo do paralelo 13° à região da Amazônia Legal, 

contemplando fitofisionomias de cerrado, região de transição e floresta. Na atualidade 

é considerada fronteira de ocupação agrícola da soja e cana-de-açúcar, da frente 

proveniente do sul do país e ao Norte a exploração da floresta por empreendimentos 

pecuários de gado bovino extensivo. Seguindo o modelo de decisão para implantação 

de rodovias da Amazônia, a partir do desmembramento do estado do Tocantins de 

Goiás em 1988, foram implantados no estado mais de quatro mil quilômetros de 

rodovias buscando integrar as regiões isoladas aos grandes eixos de 

desenvolvimento. 

A pesquisa foi desenvolvida considerando o caso da proposta da 

implantação da rodovia TO-247, ligação entre as sedes municipais Lagoa do 

Tocantins e Mateiros situadas na região conhecida como Jalapão, inserida na área 

leste do estado do Tocantins, fazendo divisa com os estados do Piauí, Maranhão e 

Bahia. A localização da área do estudo está ilustrada na Figura 2. 

O Jalapão foi classificado como Região Administrativa XII – Novo Acordo, 

conforme o Zoneamento Ecológico Econômico da Secretaria de Planejamento 

(TOCANTINS, 2008) composta por oito municípios: Mateiros, Lagoa do Tocantins, Rio 

Sono, São Félix do Tocantins, Ponte Alta do Tocantins, Lizarda, Santa Tereza do 

Tocantins e Novo Acordo, totalizando uma área aproximada de 30.341,8779km2 ou 3 

milhões e 34mil e 877 ha. A sede municipal de Lagoa do Tocantins está situada à 

120km da capital Palmas, com acesso pavimentado, sendo que o município de 

Mateiros está a aproximadamente 400 Km sendo acessado por rodovia em parte de 

revestimento primário e a partir de Novo Acordo a Palmas por acesso pavimentado. 

Os municípios interceptados pela rodovia a ser pavimentada, são Lagoa do 

Tocantins, Ponte Alta do Tocantins e Mateiros, possuem as mais baixas densidades 

demográfica do estado, chegando a menos de 1 hab/Km² (IBGE, 2010). Atualmente, 

não há interligação viária entre as sedes municipais, assim o empreendimento em 
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estudo é caracterizado como indutor de desenvolvimento, e tem a condição de 

primeiro projeto de pavimentação a ser implantado no Jalapão. 

Objetivando incrementar o desenvolvimento turístico, propôs-se, também 

melhorar o acesso aos dois principais pontos turísticos, Cachoeira da Velha situada 

no rio Novo, e as Dunas, formação paisagística de extrema beleza, criada a partir de 

erosão eólica. Na Tabela 2 seguem as coordenadas de localizações das sedes 

municipais a serem interligadas e pontos turísticos. 

 

 
Figura 2. Mapa de localização da área de estudo, inseridas nas Bacias do rio Sono e Bacia do rio das 

Balsas, região do Jalapão – TO. 

Fonte: TOCANTINS, 2008.  
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TABELA 2. 
Coordenadas das sedes municipais da área de estudo. 

 

Coordenadas dos pontos 

Datum SAD 69 – Meridiano Central 45ºWGr 
Local Latitude Longitude 

Lagoa do Tocantins 10º17’47” 47º33’40” 

Cachoeira da Velha 10º16’16” 46º52’44” 

Dunas 10º33’52” 46º39’40” 

Mateiros 10º32’44” 46º25’02” 
Fonte: dados da pesquisa (2008). 

 

A área de estudo utilizada neste trabalho justifica-se devido à sensibilidade 

ambiental inerente à região principalmente quanto ao meio físico, no que se refere aos 

solos e recursos hídricos, sendo que os ecossistemas estão praticamente 

preservados em sua maioria. 

A rodovia a ser projetada está na categoria Classe III – rodovia de pista 

simples, suportando volumes médio de tráfego de 300 veículos diários, de acordo com 

recomendações do DNIT (1999) e rampa máxima de 9%. 

 

4.2 Caracterização Ambiental 

 

A região Jalapão apresenta características muito peculiares, com destaque 

para uma grande parte desta com indicação de potencial do uso restritiva – Áreas de 

conservação ou com alta limitação natural para uso, classificadas pelo Zoneamento 

Ecológico Econômico da SEPLAN (TOCANTINS, 2008). 

De acordo com a regionalização climática do Atlas do Tocantins 

(TOCANTINS, 2008), adotando-se o Método de Thorntwaite-Mather predomina na 

região o Clima Subúmido Seco – C1dA’a’, com moderada deficiência hídrica no 

inverno, evapotranspiração média anual de 1.300 mm. Nas proximidades de Lagoa do 

Tocantins ocorre também o Clima Úmido Subúmido – C2wA’a’, com moderada 

deficiência hídrica, evapotranspiração média anual de 1.500mm. A precipitação média 

é de 1.500mm/ano, marcadamente distribuída por 6 meses de período chuvoso e 6 
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meses de estação seca e a temperatura média anual varia de 27°C a 29°C de leste 

para oeste (sentido Mateiros a Lagoa do Tocantins). 

A região pertence ao Sistema Hidrográfico do Rio Tocantins, contemplando 

as Bacias do rio Sono – T10 e do rio das Balsas – T9, conforme Atlas do Tocantins 

(TOCANTINS, 2008). A área do estudo é composta por 13 sub-bacias, sendo 8 da 

Bacia do rio Sono e 5 da Bacia do rio das Balsas. 

As duas bacias identificadas seguem alinhamentos preferenciais E-W pois 

a rede hidrográfica está fortemente correlacionada com os lineamentos estruturais 

presentes na região, verificado por Mendes (2008)b em dissertação que utilizou o 

Modelo Digital do Terreno obtido das imagens SRTM. 

Compreende depressões de recuo das escarpas da Serra Geral de Goiás e 

da Chapada das Mangabeiras, onde podem ser observados alguns testemunhos da 

história natural regional como a Serra do Espírito Santo, Serra da Jalapinha entre 

outros. 

O início do trecho, no município de Lagoa do Tocantins está inserido 

regionalmente nos ambientes geológicos da Bacia Sedimentar do São Francisco, 

segue adentrando a Bacia Sedimentar do Parnaíba predominante na área do estudo 

até o município de Mateiros. O rio Sono está inserido na Bacia Sedimentar do São 

Francisco onde ocorre a Formação Urucuia. A Bacia do Parnaíba é considerada 

paleozóica, mas contém também outros depósitos como o cenozóico e o mesozóico 

poucos espessos. O Devoniano nesta bacia está representado pelo Grupo Canindé, 

composto pelas Formações Pimenteiras, Cabeças, Longá e Poti, da base ao topo. Na 

área do estudo, predomina na Bacia do rio Balsas a Formação Pimenteiras (Dp), de 

acordo com Seplan (2008) é composta por arenitos finos a grosseiros, siltitos, siltitos 

foliáceos ferruginosos, argilitos, níveis conglomeráticos e microconglomeráticos 

subordinados. 

A área em estudo encontra-se inserida em sua maior porção, na Unidade 

Geomorfológica denominada Chapadas do Jalapão. A Dissecação homogênea com 

feições Topo Convexas e Topo Tabulares, Partindo da sede municipal de Lagoa do 

Tocantins até o divisor entre a Bacia do Rio Sono o relevo é condicionado a formas 

estruturais do Aplanamento de Pediplano Degradado Desnudado – Pgu. De acordo 

com a estrutura geológica os processos morfodinâmicos geraram formas de relevo, 

em que camadas mais resistentes sobressaem no relevo. 
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A forma de relevo entalhada por agentes erosivos, tipo de dissecação 

classificado por SEPLAN (TOCANTINS, 2008) como Dissecado em Colinas – Dc é 

predominante na região do estudo, principalmente ao longo da rede hidrográfica.  Os 

canais de drenagens são geralmente curtos e pouco aprofundados. O relevo vai de 

levemente ondulado a ondulado, destacando as áreas acidentadas onde estão 

previstos a realização de cortes e aterros. 

Os dois compartimentos localizados nas imediações da sede municipal de 

Lagoa do Tocantins são o Aplanamento de Pediplano Retocado Desnudado – Pru e 

nas margens do rio das Balsas a Acumulação Fluvial de Planície e Terraço, 

caracterizado por relevo resultante de depósito de sedimentos. Individualizada em 

altitudes entorno de 800m. 

Na Bacia do rio Sono predomina os solos do tipo Areias Quartzosas – AQ6 

e AQ3 (TOCANTINS, 2008) ou Neossolos Quartzarênicos (EMBRAPA, 1999). Esta 

classificação envolve associações das Areias Quartzosas distróficas com outros solos, 

a exemplo do AQ6 que é composto por associação de Areias Quartzosas distróficas 

em relevo suave ondulado com areias quartzosas hidromórficas de ocorrência em 

relevo plano, ainda associado a Glei Pouco Húmico. Já o solo AQ3 envolve 

associação com Latossolo Vermelho-Amarelo distrófico em relevo suave ondulado. 

Outra classificação encontrada com grande freqüência é dos solos 

concrecionários – SC9 e SC5 (TOCANTINS, 2008), descritos como associações 

destes com Podzólico Vermelho-Amarelo em relevo ondulado, mais Latossolo 

Vermelho Amarelo em relevo suave ondulado (SC9). No caso da classe SC5 a 

associação é com o Latossolo Vermelho-Amarelo distrófico em relevo suave ondulado 

a ondulado (SC9). 

Ocorrem ainda na área do estudo: Latossolo Vermelho Escuro – LE1, o 

Latossolo Vermelho-Amarelo – LV1,  Latossolo Amarelo – LA1, Podzólico Vermelho 

Amarelo – PV6 e Solos Litólicos – R2 ou Litossolo. 

A região do estudo encontra-se inserida no Bioma Cerrado ou região 

fitoecológica Savana (Cerrado) (TOCANTINS, 2008) com predominância de 

vegetação xeromorfa aberta, dominada e marcada por um estrato herbáceo. 

Predomina o Campo Cerrado (CC) – vegetação de estrato graminóide natural ou 

antropizado entremeados por plantas lenhosas de pequeno porte, podendo ou não 

conter mata ciliar associada aos canais de drenagens, onde foi verificada a ocorrência 
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de “nanismo”. Ainda foram identificadas ocorrência de Savana arborizada, Savana 

Parque e Savana Gramíneo Lenhosa com Floresta de Galeria.  

Destacam-se a existência de 5 Unidades de Conservação de administração 

Federal (ICMBio) e Estadual (Naturatins) na região do Jalapão, sendo 3 Unidades na 

área do estudo: Parque Estadual do Jalapão, APA Estadual do Jalapão e Estação 

Ecológica Serra Geral do Tocantins. 

A Agência de Desenvolvimento Turístico do estado do Tocantins - ADTUR 

destaca na região14 atrativos turísticos relacionados à água (TOCANTINS, 2006) 

exaltando o potencial turístico da região e a riqueza dos recursos hídricos, um dos 

principais atrativos: 
“o Jalapão abriga um cenário exótico de rara beleza(...) a região 

é toda cortada por incontáveis riachos de águas puras com suas corredeiras, 

cachoeiras e piscinas naturais(...) e o mistério das águas do Fervedouro, 

nascente subterrânea que nos faz flutuar na realidade do sonho de estar em 

harmonia com a natureza” 

 

 
Figura 3. Atrativo turístico: Cachoeira da Velha, município de Ponte Alta (TO). 
Fonte: Foto de Márcio Di Pietro. 
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Figura 4. Atrativo turístico: Dunas, município de Mateiros (TO). 
Fonte: Foto de Márcio Di Pietro. 

 

Segundo dados da EMBRAPA (2003) 80% da área do Jalapão é coberta 

por vegetação nativa, sendo reduzidos os locais ocupados por uso antrópico como a 

agricultura e pecuária que contempla somente 10% da área. 

 

4.3 Aplicação do modelo proposto 

 

4.3.1 Definição da área do estudo 
 

As bacias de inserção das sedes municipais de Mateiros e Lagoa do 

Tocantins foram identificadas na base de dados da SEPLAN (TOCANTINS, 2008) – 

shape  de Bacias Hidrográficas e Sub-bacias. A Bacia do Rio Sono e Bacia do Rio das 

Balsas foram selecionadas e criada uma nova shapefile no ArcGis-ArcInfo-ArcMap: 

Data→Export Data→nome:AE. 

A área de estudo totalizou  34mil e 877 ha, comportando 13 sub-bacias. 

Foram excluídas da área para efeito do trabalho 5 sub-bacias que se encontravam 

afastadas além dos Buffers de 30 Km das rodovias existentes identificadas, 

consideradas fora da possível área de influência (BELLIA e BIDONE, 1993). 

Os dados de campo foram levantados através de 2 campanhas durante o 

ano de 2009 e 2010 e os dados digitais foram obtidos em sites de acesso gratuito ou 

disponíveis nos órgãos e instituições. 
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4.3.2 Aquisição dos dados da área do estudo 
 

A obtenção das 13 sub-bacias da área do estudo foi efetuada com base na 

divisão proposta pela SEPLAN (TOCANTINS, 2008). 

 

 
Figura 5. Mapa de sub-divisão da 13 sub-bacias que compõem as Bacias do rio das Balsas e Bacia do 
rio Sono. 
Fonte: Dados da pesquisa, 2008. 
 
 
4.3.3 Pré-processamento e análise dos dados 

 

Foram produzidos os mapas de atrito para cada tema de restrição 

conforme a metodologia proposta, quanto aos aspectos ambientais, aspectos 

construtivos e aspectos socioeconômicos. 
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4.3.3.1 Aspectos ambientais 

   

(i) Mapa de atrito para de uso do solo 

 

Através do mapa de uso do solo foi produzido o mapa de atrito relacionado 

às dificuldades impostas à área ambiental no que se refere à cobertura e uso da terra. 

As áreas de dunas tiveram a passagem vedada, devido às condições de 

fragilidade ambiental. 

As áreas urbanizadas foram consideradas com maior dificuldade de 

passagem devido a necessidade de reassentamento populacional e as questões de 

segurança da travessia, seguem-se as vegetações nativas que são impactadas 

necessitando de desmatamento subdivididas em dois níveis de penalização. Também 

foram consideradas restritas as áreas antropizadas com cultivos diversos. Às praias e 

corpos d’água não foram atribuídas nenhuma restrição. Segue a Tabela 3 com a 

classificação aplicada. 

TABELA 3. 
Reclassificação com agrupamento dos indicadores de uso do solo 

 

RESTRIÇÃO – SEPLAN  RESTRIÇÃO - DISSERTAÇÃO 
GRAU DE 

PENALIZAÇÃO 

Praias e Dunas Praias e Dunas 1000 

Áreas urbanizadas Área Urbanizada 7 

Mata de Galeria/Mata Ciliar Vegetação Nativa associada a 

cursos d’água 

6 

 Vereda 

Cerradão Vegetação Nativa – florestal e 

savânica 

5 

Cerrado Sentido Restrito 

Floresta Estacional 

Semidecidual Aluvial 

Floresta Estacional 

Semidecidual Submontana 

Campo Vegetação Nativa - Campestre 3 

Campo Rupestre 

Capoeira 

(cont.) 
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(cont.) 

RESTRIÇÃO – SEPLAN  RESTRIÇÃO - DISSERTAÇÃO 
GRAU DE 

PENALIZAÇÃO 

Reflorestamento Áreas Rurais Antropizadas 2 

Agropecuária 

Cultura Temporária 

Corpos d’água continental Corpos d’água 1 
Fonte: Tocantins, 2008 e Dados da pesquisa. 

 

As classes do tema de uso do solo em formato shape obtido na base de 

dados geográficos disponibilizados pela Seplan (TOCANTINS, 2008) tiveram que ser 

reagrupadas conforme semelhança de restrição com os procedimentos que seguem 

no ArcGis- ArcMap-ArcInfo para a toda a área do estudo: 

 Add data→ Uso do solo; 

 Acionar a tabela de atributos: Open Attribute Table 

 Criar um novo campo na tabela de atributos do arquivo: Options  →Add 

Field→Name. Escolher→Type Text. Preencher com o nome: classf_uso; 

 Open Atribute Table→Options→ Select by Atribute→ nome→Like→ Get 

Unique Values  → ex: Mata de galeria ou Cerrado→ Apply; 

 Selecionar a field Classf_uso, com o botão direito → Field calculator → 

ex: Vegetação Nativa → ok; 

 Repetir as operações para todas as classes de uso, limpando a seleção 

anterior: Options→Clear Selection, reclassificando conforme tabela 3, 

anterior. 

Para transformação dos arquivos vetoriais (shape) em matriciais (raster), os 

procedimentos foram: 

 Geração de raster: com a ferramenta Spatial Analyst → Convert→           

Feature to Raster; 

 No campo Input features selecionar o shape desejado→Uso do Solo; no 

campo Field selecionar o campo reclassificado anteriormente 

→Classf_uso; 

 No campo Output cell size  foi padronizado o tamanho 10m para todos 

os rasters produzidos. 
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 No campo Ouput raster escolher o local onde será salvo o arquivo 

raster. 

 

Após o reagrupamento procedeu-se a reclassificação das restrições por 

tema, sendo atribuídos pesos conforme orientação de técnicos do Departamento de 

Estradas de Rodagem do Estado do Tocantins - DERTINS e experiência da 

pesquisadora, de acordo com as operações do ArcGis: 

 Spatial Analyst→ Reclassify → Input raster  Uso do Solo; 

 New Values→ ex: pesos escolhidos. 

 

 (ii) Mapa de atrito de unidades de conservação e áreas protegidas 

 

As unidades de conservação identificadas na área do estudo foram: 

Estação Ecológica Serra Geral do Tocantins (Unidade Gestora  - ICMBio), Parque 

Nacional das Nascentes do Rio Parnaíba (Unidade Gestora  - ICMBio), APA Serra da 

Tabatinga (Unidade Gestora  - ICMBio), Parque Estadual do Jalapão (Unidade 

Gestora – Naturatins) e APA Jalapão (Unidade Gestora –Naturatins). 

Seguindo a recomendação prevista na legislação vigente, o SNUC e 

SEUC, a unidade com máxima restrição é a Estação Ecológica, seguida pelos 

Parques, ambas classificadas como de proteção integral, tendo sido considerada área 

vedada à passagem da rodovia na Estação. A tabela 4 apresenta a parametrização 

proposta. As Terras Indígenas são áreas onde são permitidas a construção de 

estradas, porém com restrição semelhante à das unidades de conservação de uso 

sustentável, em alguns casos, como de proteção integral, necessitando medidas de 

grau alto de dificuldade para sua execução. 

O procedimento de reagrupamento e atribuição de pesos das unidades de 

conservação  foram executadas em ArcGis-ArcInfo-ArcMap e seguiram as mesmas 

orientações do mapa de atrito do potencial de uso do solo, com o grau de penalização 

proposto. 
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TABELA 4. 
Grau de penalização das categorias de Unidades de Conservação ou Áreas 

Protegidas. 
 

RESTRIÇÃO – SEPLAN  
RESTRIÇÃO - 

DISSERTAÇÃO 
GRAU DE 

PENALIZAÇÃO 

Estação Ecológica Estação Ecológica 1000 

Área Indígena Área Indígena 10 

Parque Nacional ou Estadual Parque Nacional ou Estadual 10 

Área de Proteção Ambiental – 

APA 

Área de Proteção Ambiental - 

APA 
3 

Sem unidade Sem unidade 1 
Fonte: Tocantins, 2008 e dados da pesquisa. 

 

 (iv) Mapa de atrito das APP’s das nascentes e zona tampão dos 
cursos d’água 

 

Neste trabalho foi vedada a passagem nas Áreas de Preservação 

Permanentes - APP’s, (50m de raio a partir da nascente) sendo atribuído grau de 

restrição 1000. O incremento deste critério ambiental à fase de planejamento virá 

contribuir para a preservação destas áreas, ainda que os dados disponibilizados no 

mapa de hidrografia foram na escala 1:100.000. Nos casos praticados nos projetos 

rodoviários, somente são vedadas a passagem nestas áreas em caso de uso humano 

da água ou em situações de associações a questões de relevância ambiental 

específica. 

Em ambiente ArcMap utilizou-se a extensão XTools Pro, gerou-se os 

pontos de nascentes e foi criado um buffer de 50m para cada ponto representando as 

Áreas de Preservação Permanentes – APP’s das nascentes. 

Foi proposta a aplicação de Buffer de 100m de todos os cursos d’água e  

restrições maiores à passagem da rodovias nestas áreas, sendo que às demais áreas 

foram consideradas sem restrição, pois serão necessárias distâncias muito grandes 

para obtenção de pequenos ganhos em redução do escoamento. 

Utilizou-se a ferramenta Buffer localizada no menu Analysis Tools da 

ferramenta ArcToolBox: →Proximity→Buffer, no campo Input Feature selecionar o 

shape de drenagem da área do estudo da Seplan (TOCANTINS, 2008) e no campo 
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Distance →100 e para Unit selecionar meters. No campo Dissolve Type → All, para 

eliminar possíveis inconsistências da drenagem. 

Transformou-se o arquivo vetorial para matricial, através da opção Spatial 

Analyst→Convert→Features to raster. A  partir do arquivo matricial gerado, foi 

efetuada a reclassificação, onde a todas células internas do buffer foi atribuído valor 

10, considerada Zona Tampão e nas áreas valor 1. Spatial Analyst→ Reclassify → 

Input raster  Zona Tampão; New Values→ 10 e No Data→ 1. 

 

4.3.3.2 Aspectos construtivos 

 
(v) Mapa de atrito de obras de arte 

 

A minimização da dificuldade construtiva relacionada ao número de cursos 

d’água a serem transpostos foi tratada através da penalização destes impondo 

restrições através do seu porte. Utilizou-se recorte da imagem SRTM da área do 

estudo, classificando a drenagem, através do fluxo acumulado, conforme contribuição 

total das células por área drenada.  

Segue tabela 5 com classificação proposta por técnicos da Diretoria de 

Projetos do Dertins (TOCANTINS, 1994), apoiado na classificação utilizada para 

cálculo de vazões e dimensionamento dos bueiros e pontes. 
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TABELA 5. 
Classificação das bacias por área, modalidades de obras de arte e grau de 

penalizaçao. 
 

ÁREA DA BACIA CLASSIFICAÇÃ
O DA BACIA / 

MÉTODO PARA 
VAZÃO 

TIPO DE 
OBRA DE 

ARTE 

CUSTO 
CONSTRUTIVO 
OA (larg.16m) 

GRAU 
DE 

PENALI
ZAÇÃO 

≤1Km² (100ha) Pequena - - 1 

1Km² >a≤5Km²  (100 - 

500ha) 

Pequena 

(Racional) 

Bueiros 

tubulares ou 

celulares 

BSTC Ø 1m  

R$712,00/m 

3 

5Km²>a≤10Km²   (500 

– 1000ha)  

Intermediárias 

(Racional e 

coeficiente de 

retardamento) 

Bueiros 

tubulares ou 

celulares 

BSCC 3x3m  

R$8.700,00/m 

5 

>10 Km² 

(>1.000ha) 

1.207.58 

>10a≤ 

30Km² 

Grandes 

(Hidrograma 

Unitário – HUT) 

Bueiros 

celulares ou 

Pontes 

PCA 10,40m(larg)  

R$30.000,00/m 

6 

>30Km² 8 

Fonte: TOCANTINS, 1994 e dados da pesquisa. 

 

Através da obtenção do Modelo Numérico do Terreno – MNT da missão 

SRTM foi extraída a drenagem. O uso do ArcGis permitiu reagrupar, reclassificar e 

graduar a interceptação dos cursos d’água. Com a operação de reclassificação foram 

pontuadas as drenagens conforme área da bacia drenada. 

1. As imagens SC-23-Y-D, SC-23-Y-B, SC-23-V-D, SC-23-Y-C, SC-23-Y-

A, SC-23-V-C, SC-23-V-A, SC-22-Z-B, SC-22-X-D, SC-23-X-B, foram 

baixadas do site da Embrapa (MIRANDA, 2005); 

2. Foi efetuado o mosaico que compõe a área de estudo e posteriormente 

o recorte da mesma; 

3. Remoção das depressões através do ArcGisArcInfo: Spatial Analyst 

Tools→Hidrology→Fill; 
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4. Obtenção dos arquivos de direção de fluxo e fluxo acumulado: Spatial 

Analyst Tools→Hidrology→Flow Direction e Spatial Analyst 

Tools→Hidrology→Flow Accumulation; 

5. A partir das imagens com as depressões removidas e o fluxo de direção 

gerado, proceder foi efetuado o reagrupamento das células das 

drenagens conforme a tabela 5: Spatial Analyst 

Tool→Reclassify→Classify entrar com 5classes→break 

values→121(referente a nº de células drenado para áreas abaixo de 1 

Km²), 604 ( 5 Km²), 1.207 (10 Km²) 3.623 (30 Km²); 

6. Fazer a reclassificação com os pesos atribuídos na tabela 5: Spatial 

Analyst Tool→Reclassify atribuir os novos valores New value→1 (para 

até 121 células), 3 (604), 5, 6 e 8 suscessivamente. 

. 

(vi) Mapa de atrito de gradiente de rampa 

 

O caso do estudo prevê a construção de uma rodovia classe III, sendo que 

são permitidas rampas de até 9% de declividade, tolerando-se a instalação de rampas 

até 10%, uma vez que a modernização dos veículos de transporte permite o 

desenvolvimento com segurança nesta classe. 

Através do mapa de declividade, onde as classes de declividade foram 

geradas a partir do MNT, obtido da digitalização das curvas de nível com eqüidistância 

de 100m (TOCANTINS, 2008) foi efetuado o reagrupamento das classes e 

associações e a reclassificação no ArcGis para os parâmetros indicados de acordo 

com a dificuldade imposta pela necessidade de construção de rampas ou realização 

de cortes e aterros. 

Na extensão 3D Analyst→Surface Analysis→Slope entrar com a imagem 

SRTM com as depressões removidas, escolher o campo %. Efetuou-se o 

reagrupamento e a reclassificação atribuindo os graus de penalização da tabela 6. 
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TABELA 6.  
Reclassificação dos indicadores de declividade e grau de penalização das 

classes de declividade 
 

RESTRIÇÃO – SEPLAN  
RESTRIÇÃO – 
DISSERTAÇÃO 

GRAU DE 
PENALIZAÇÃO 

Classe A (declive ≤ 5%) Declive ≤ 10% 1 

Classe AB - Mosaico com 

predomínio de A sobre B 

Classe B (5% >declive ≤10% ) 

Classe BC - Mosaico com 

predomínio de B sobre C 

Classe C (10% >declive ≤15%) 10% >declive ≤15%  

e associações 

2 

Classe CB - Mosaico com 

predomínio de C sobre B 

Classe CD - Mosaico com 

predomínio de C sobre D 

Classe D (15% > declive ≤ 30%) 15% > declive ≤ 30% 

e associação 

5 

Classe DC - Mosaico com 

predomínio de D sobre C 

Classe E (30%> declive  ≤ 45%) 30%> declive  ≤ 45% 8 

Classe F (declive > 45%) Declive > 45% 10 
Fonte: TOCANTINS, 2008 e dados da pesquisa. 

 

4.3.3.3 Aspecto socioeconômico 
 

(viii) Mapa de atrito dos pontos turísticos 

 

Entre os aspectos socioeconômicos da implantação e pavimentação da 

rodovia TO-247 foi identificado o anseio dos políticos e comunidade local em facilitar o 

acesso aos principais pontos turísticos Cachoeira da Velha e Dunas. A Cachoeira da 

Velha está localizada no rio Novo, afluente do rio Sono e apresenta grande beleza 

cênica com duas quedas de 20m cada uma, servida ainda pela Prainha, praia natural 

permanente formada à jusante da cachoeira, muito utilizada para camping. As dunas 

do Jalapão são formações de até 30m de altura, compostas por areias quartzosas 
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originada de erosão eólica proveniente da Serra do Espírito Santo que rodeia a área 

juntamente com pequeno manancial de água. 

 

TABELA 7. 
Localização dos pontos turísticos. 

 
Coordenadas dos pontos (UTM) 

Datum SAD 69 – zona 23S 

Local E N 

Cachoeira da Velha 294.201,692 8.863.991,096 

Dunas 318.221,902 8.831.675,420 
Fonte: Dados da pesquisa, 2008. 

 

No caso, foi considerada a necessidade de aproximar a rodovia 

pavimentada do acesso aos pontos turísticos visando incrementar o turismo regional e 

a sua acessibilidade. Assim, estabeleceu-se como patamar de atrito superior de peso 

10, uma distância superior a 20 km, enquanto que o patamar de atrito inferior de peso 

1 ficou a uma distância de 1 a 5 km. Foi vedada a passagem na área do ponto 

turístico até uma distância de 1 km, afim de evitar danos ambientais. 

De posse das coordenadas geográficas dos pontos turísticos levantadas 

em campo, utilizando-se do ArcGis-ArcMap-ArcInfo, foram construídos buffers em 

faixas conforme tabela 8, que tiveram seu grau de restrição variando linearmente.  

Utilizou-se a ferramenta Buffer localizada no menu Analysis Tools da 

ferramenta ArcToolBox: →Proximity→Buffer, no campo Input Feature selecionar o 

shape dos pontos turísticos.  

1 Restringiu-se a passagem a partir dos pontos turísticos, num raio de 1 

km. ArcToolBox: Analysis Tools→Proximity→Buffer, no campo Input 

Feature selecionar o shape dos pontos turísticos, no campo 

Distance→1, acionar a unidade kilometers, acionar Full, round e none 

para os demais campos; 

2 Prosseguiu-se com o mesmo método para as demais distâncias 

propostas na tabela 8; 

3 Efetuou-se a imersão dos polígonos com a opção: ArcToolBox: →Data 

Management Tools→General→Merge¸ inserir todas as shapes; 
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4 Converteu-se o arquivo vetorial para matricial: Spatial 

Analyst→Convert→Feature to raster; 

5 Reclassificou-se a shape gerada atribuindo os graus de penalização: 

Spatial Analyst→ Reclassify → Input feature  [Turismo]; New Values→ 

conforme tabela 8. 

 

TABELA 8. 
Reclassificação dos indicadores de distância para pontos turísticos. 

 

Fonte: Dados da pesquisa, 2009. 

 

4.3.4 Produção e aporte de sedimentos 
 

4.3.4.1 Aplicação da USLE 

 

A estimativa de perdas anuais de solo em t.ha-1 foi obtida com a aplicação 

da equação universal de perdas de solos – USLE (Universal Soil Loss Equation) 

(WISHMEIER & SMITH, 1978) que não prevê deposição e não computa produção de 

sedimentos por ravina e erosão das margens e fundo do canal. A obtenção da 

produção total de sedimentos por bacia foi obtido a partir da equação 1. 

 

PCSLKRA    (1) 

Onde: 

A = perda de solo calculada por unidade de área, t/ha.ano; 

R = fator de erosividade da chuva e run-off , MJ.ha-1.mm. h-1; 

K = fator de erodibilidade do solo, tmh/ha.mm; 

L = fator comprimento do declive (adimensional); 

RESTRIÇÃO – DISSERTAÇÃO GRAU DE PENALIZAÇÃO 

D > 20 km 6 

20 Km > D  ≤ 15 Km 4 

15 > D ≤ 10 3 

10 > D ≤ 5 2 

5 > D ≤ 1 1 

D<1 1000 
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S = fator grau do declive (adimensional); 

C = fator uso e manejo de culturas (adimensional); 

P = fator práticas conservacionistas (adimensional). 

 

O desenvolvimento da metodologia foi efetuado para cada sub-bacia das 

bacias principais – Rio Sono – T-10 e Rio das Balsas – T-9, com o intuito de verificar a 

sensibilidade ambiental relacionada a produção total de sedimentos (USLE) e 

posteriormente o aporte de sedimentos (SDR) de cada uma. 

Os mapas e imagens SRTM foram recortadas com o uso de ferramentas 

do ArcMap-ArcInfo conforme divisão proposta pela SEPLAN expressos na tabela 9. 

 
TABELA 9. 

Dados de perímetro e área das sub-bacias da bacia do rio das Balsas – T9 e 
bacia do rio Sono - T10. 

Bacias Sub-bacia Perímetro Km Área Km² Área ha 

T-9 Bacia do Rio das Balsas 819,6853917 6.984,107726 698.410,7726 

T-9 Sub-bacia Córrego Caracol 157,7164892 846,1294455 84.612,94455 

T-9 Sub-bacia Rio Ponte Altinha 136,1189524 724,279928 72.427,9928 

T-9 Sub-bacia Rio Ponte Alta 344,4053105 2.548,687387 254.868,7387 

T-10 Bacia do Rio Sono 923,3144163 6.354,573501 635.457,3501 

T-10 Sub-bacia Rio Soninho2 280,4054119 2.990,778875 299.077,8875 

T-10 Sub-bacia Rio Caracol 209,4046442 1.533,283502 153.328,3502 

T-10 Sub-bacia Rio Monte Santo 110,0014218 449,3825485 44.938,25485 

T-10 Sub-bacia do Rio Soninho3 157,1250175 604,8139544 60.481,39544 

T-10 Sub-bacia Rio Novo 395,3294731 4.371,289532 437.128,9532 

T-10 Sub-bacia Rio Preto 159,9512443 807,1426385 80.714,26385 

T-10 Sub-bacia Rio Soninho 174,4844815 914,4938194 91.449,38194 

T-10 Sub-bacia Rio Vermelho 217,7938901 1.212,915081 121.291,5081 
FONTE: Dados da pesquisa, 2009. 

 

(i) Fator de erosividade da chuva (R) 
 

Para as duas bacias hidrográficas estudadas foram identificadas 14 postos 

e estação pluviométricos no interior das bacias ou nas proximidades, sendo então 

extraídos os valores diários de precipitação no site da Agência Nacional de Águas. De 
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posse destes dados obteve-se os valores das médias mensais e anuais, que 

aplicados a equação (2) resultou na erosividade média mensal e através das suas 

somatórias chegou-se a erosividade total. A tabela 10 demonstra os resultados 

obtidos de erosividade por estação e posto pluviométricos identificados. Através dos 

valores da erosividade e da localização geográfica dos postos e estação, gerou-se a 

matriz dos valores de erosividade para cada ponto das bacias, através da interpolação 

do inverso do quadrado da distância (IDW) em ArcGis, como demonstrado na Figura 

6. 
759.02

823.89 







 

P
rEI    (2) 

Onde: 

EI = erosividade média mensal do mês i (MJ mm.ha-1 h-1); 

r = precipitação média mensal do mês (mm); 

P = precipitação média anual (mm). 

 
TABELA 10. 

Demonstrativo das erosividades calculada por posto e estação pluviométricos. 
 

Código Município/Nome Início Fim Período Consistido 
Erosividade 

(MJ.ha-1.mm. h-1) 

0114700 Almas - TO 1973 2006 33 anos Sim 8.527,6 

1045006 Formosa do Rio 

Preto – BA 

(Coaceral) 

2001 2006 5 anos Sim 7.774,9 

946003 Lizarda - TO 1973 2006 33 anos Sim 8.431,6 

1046001 Mateiros - TO 1998 2006 8 anos Sim 9.761,0 

1047002 Monte do Carmo 

– TO 

1969 2006 37 anos Sim 8.734,7 

1047000 Novo Acordo – 

TO (Jatobá - Faz. 

Boa Nova) 

1973 2006 33 anos Sim 8.840,6 

1047001 Novo Acordo 1971 2006 35 anos Sim 8.321,7 

(cont.) 
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(cont.) 

Código Município/Nome Início Fim Período Consistido 
Erosividade 

(MJ.ha-1.mm. h-1) 

1048005 Palmas – TO 

(Taquarussu do 

Porto) 

1976 2006 30 anos Sim 9.497,3 

948001 Pedro Afonso – 

TO (Porto Real) 

1969 2006 37 anos Sim 8.471,8 

848004 Pedro Afonso - 

TO (23) 

1949 2008 49 anos sim 7.395,7 

1147002 Pindorama do TO 1973 2006 33 anos Sim 8.746,2 

1047004 Ponte Alta do TO 1984 2006 22 anos Sim 8.012,4 

1048003 Porto Nacional – 

TO (Palmas) 

1949 1998 49 anos Sim 8.352,0 

947001 Rio Sono – TO 

(Mansinha) 

1983 2006 23 anos Sim 9.081,5 

847000 Santa Maria – TO/ 

Conceição 

1998 2006 28 anos Sim 9.455,36 

FONTE: ANA, 2010 e dados da autora. 
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Figura 6. Mapa de erosividade das chuvas na região do Jalapão – TO. 
Fonte: Dados da pesquisa, 2009. 

 

(ii) Fator de erodibilidade dos solos (K) 

 

A elaboração da matriz de erodibilidade dos solos do estudo partiu dos 

valores calculados através do nomograma de Wischmeier et al. (1971) citado por 

Farinasso et al. (2006) para a região do Alto Parnaíba, inserida nas proximidades das 

Bacias desta pesquisa e segundo proposição de Baptista (1977). Com o uso do 

ArcGisArcInfo foi reclassificado o mapa de pedologia (TOCANTINS, 2008) e atribuído 

os valores de erodibilidade, conforme dados expostos na tabela 11. 
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TABELA 11. 
Valores de fator K para as classes de solo da área do estudo. 

 
TIPOS DE SOLOS 

ADAPTADOS 

(TOCANTINS, 2008) 

TIPOS DE SOLOS 

(EMBRAPA, 1999) 
FATOR K (t.ha.h/ha.MJ.mm) 

Areia Quartzosa 

Distrófica (AQd) 

Neossolo Quartzarênico Órtico 
0,041 (Farinasso et al., 2006) 

Latossolo Vermelho 

Escuro Distrófico  (LEa) 

Latossolo Vermelho Escuro 

Distrófico 
0,018 (Farinasso et al., 2006) 

Latossolo Vermelho 

Amarelo Distrófico 

(LVa) 

Latossolo Vermelho Amarelo 

Distrófico 0,020 (Baptista, 1997) 

Latossolo Roxo 

Distrófico (LR) 

Latossolo Vermelho Distrófico 
0,014 (Farinasso et al., 2006) 

Latossolo Amarelo 

Distrófico (LA1) 

Latossolo Amarelo Distrófico 
0,028 (Farinasso et al., 2006) 

Litossolo Eutrófico (Re) Neossolo Litólico Eutrófico 0,036 (Farinasso et al., 2006) 

Litossolo Distrófico (Rd) Neossolo Distrófico 0,052 (Farinasso et al., 2006) 

Podzólico Vermelho-

amarelo Concrecionário  

Distrófico 

Argissolo Vermelho-Amarelo 

0,044 (Farinasso et al., 2006) 

Fonte: Autores diversos. 

 

(iii) Fator topográfico (LS) 

 

Através da equação (3) de Wischmeier & Smith (1978) foi obtido o fator LS. 

  

 06505644165
1322

2 .sin,sin.
.







 

nxLS  (3) 

Onde:  

x = comprimento de rampa de escoamento; 

θ = declividade do terreno; 

n = 0.5 se θ ≥ 4.5% 
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 0.4 se 3 ≤ θ < 4.5% 

0.3 se 1 ≤ θ<3% 

0.2 se θ ≤ 1% 

 

Para obtenção do fator topográfico foi utilizado somente o MNT, através 

das imagens SRTM, em recorte da área de estudo, conforme a descrição que segue. 

 As imagens SC-23-Y-D, SC-23-Y-B, SC-23-V-D, SC-23-Y-C, SC-23-Y-A, 

SC-23-V-C, SC-23-V-A, SC-22-Z-B, SC-22-X-D, SC-23-X-B, foram 

baixadas do site da Embrapa (MIRANDA, 2005); 

 Foi efetuado o mosaico que compõe a área de estudo e posteriormente 

o recorte da mesma; 

 Remoção das depressões através do ArcGisArcInfo: Spatial Analyst 

Tools→Hidrology→Fill; 

 Obtenção dos arquivos de direção de fluxo e fluxo acumulado: Spatial 

Analyst Tools→Hidrology→Flow Direction; 

 A partir deste ponto deve  ser dividida as sub-bacias e fazer o fluxo 

acumulado para cada sub-bacia: Spatial Analyst 

Tools→Hidrology→Flow Accumulation;  

 A partir do arquivo com as depresões removidas foi obtida a declividade, 

opção em graus: Spatial Analyst Tools→Surface→Slope, marcar 

measurement→degree; 

 Conversão do mapa de declividade para radianos para obtenção do 

para obtenção do θ: Spatial Analyst→raster calculator: [arquivo 

SlopeRad] = ([DeclividadeGraus]* 3,141593) / 180; 

 Geração do arquivo de declividade em porcentagem para obtenção do 

n: Spatial Analyst Tools→Surface→Slope, marcar 

measurement→percent; 

 Obtenção do n através da reclassificação das classes de declive em 

porcentagem (θ): Inicialmente agrupa as classes, conforme valores de θ 

Properties→Symbology→Classified→4Classes→Classify; e 

reclassificação: Spatial Analyst →Reclassify. Critérios: New Value 0.5 se 

θ ≥ 4.5%; 0.4 se 3 ≤ θ < 4.5%; 0.3 se 1 ≤ θ<3%; 0.2 se θ < 1%; 
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 Obtenção do comprimento de rampa (x) inicialmente, através da 

reclassificação da matriz acumulada (Flow Accumulation), multiplicado 

pelo tamanho da célula em metros (m), no caso 91,64831. Uma vez que 

a USLE não calcula perdas de solo em canais e considerando a 

recomendação de Mendes (2005) que rampas maiores que 200m 

podem iniciar canais de drenagem. foi realizada reclassificação da 

matriz acumulada multiplicada pelo tamanho da célula da imagem, tendo 

sido atribuídos valor 1 para células com valor nulo e 200m para as 

maiores que 200 as demais mantiveram seus respectivos valores. Este 

procedimento foi realizado através dos seguintes passos:  

 No raster acessar→Properties → Symbology → Classified → Classify; 

reclassificar Spatial Analyst → Reclassify; 

 Cálculo do LS decompondo a equação (3), como segue, para facilitar o 

cálculo através da aplicação do procedimento Spatial Analyst→Raster 

Calculator:  

P1 = Pow([comprimento de rampa reclassificado (x)]/22,13, [n]) 

P2 = 65,41*Pow(Sin([SlopeRad]), 2) 

P3 = 4,56*Sin([SlopeRad])  

LS = [P1]*([P2]+[P3]+0,065) 

 

Os cálculos foram efetuados para todas as sub-bacias, sendo que a Figura 

7 representa resultado obtido nestes procedimentos para a sub-bacia do rio Vermelho. 
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Figura 7. Fator topográfico – LS da sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2009. 

 
(iv) Cálculo do fator uso e manejo do solo(C) 

 

Cabe aqui ressaltar a grande amplitude de variação entre os usos ou 

mesmo para um uso específico, no último caso, atribuído a diferentes técnicas de 

manejo e aos períodos que as mesmas são implantadas, como verificado por Fujiwara 

(2002). Portanto, através do reagrupamento dos potenciais de uso da terra proposto 

pelo Zoneamento Ecológico Econômico (TOCANTINS, 2008) utilizou-se os valores de 

C de diversos autores para reclassificação conforme explicitado na tabela 12. No 

ArcGisArcInfo foram realizadas duas operações: Spatial Analyst →Reclassify.  
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TABELA 12. 
Valores do fator C para diferentes potenciais de uso do solo 

 
POTENCIAL DE USOS 

DO SOLO - ZEE 
POTENCIAL DE USOS 

DO SOLO 
FATOR C 

Culturas de ciclo longo 

e curto 

Agricultura 0,24 (Wischimeier & Smith,1978) 

Pecuária extensiva e 

intensiva 

Pastagem 0,05 (Wischimeier & Smith,1978) 

Rio Tocantins Corpos d’água 0,00 

 

- 

Área urbana, baixa 

densidade 

0,03 (Wischimeier & Smith,1978) 

- Solo descoberto 1,00 (Wischimeier & Smith,1978) 

Conservação Natural Cerrado 0,042 (Farinasso et al., 2006) 

Silvicultura Reflorestamento 0,03241 (Silva, 2007) 
Fonte: Autores diversos.   

 

(v) Cálculo da USLE – A 

 

De posse de todos os fatores paramétricos que compõem a equação USLE 

foi efetuado o cálculo da produção de sedimentos com o auxílio do ArcGisArcInfo, 

Spatial Analyst→Raster Calculator: [Layer R]*[Layer K]*[Layer LS]* ]*[Layer C]*1  

tendo como resultado da aplicação na sub-bacia do rio Vermelho a figura 8. O valor 

unitário 1 refere-se ao fator prática de conservação do solo (P), considerando práticas 

de plantio morro abaixo, por falta de informações consistentes. 

Foi obtida a produção média de sedimentos por célula, considerando o uso 

potencial do solo para cada sub-bacia, segundo classificação do Zoneamento 

Ecológico Econômico da SEPLAN (TOCANTINS, 2008).  
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Figura 8. Perdas de solo – A (t/ha.ano) na sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2009. 

 
 4.3.4.2 Aporte de sedimentos - Movimentação Lateral  

 

A relação existente entre perdas de solos de uma bacia (balanço vertical) e 

a produção de sedimentos, medida no exutório dessa bacia é definida como Relação 

de Liberação de Sedimentos – SDR. 

Obteve-se os valores de aporte de sedimentos segundo proposto por Ferro 

& Minacapilli (1995) e Ferro (1997), de duas formas com o uso do tempo de 

deslocamento (equação 5) e com a substituição do tempo pela distância (equação 15) 

 
A. SDR com o uso do tempo de deslocamento. 

 

O SDRi corresponde a fração de produção de sedimentos para célula i, 

conforme a estrututra do banco de dados deste trabalho, foi definido como: 
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 ii tSDR  exp   (5) 

Onde:  

β é um parâmetro que representa a morfologia da bacia, assumindo-se o 

valor igual a 1 (MUTUA E KLIK, 2006, JAIN, 2000); 

ti  é o tempo de deslocamento ao longo da linha de escoamento, como 

segue na equação (6) 





jM

m m

m
j V

lt
1

 (6) 

n
SRV h

2
1

3
2

.
  (14) 

Estimou-se a velocidade com a fórmula de Chezy com o uso do Coeficiente 

de Manning,  de acordo com a fórmula 14. O coeficiente de rugosidade é o parâmetro 

mais importante da equação de Manning. Depende da cobertura vegetal ou uso do 

solo do tipo da área, em seguida a figura 9 apresenta o mapa do coeficiente de 

rugosidade (n), obtido da combinação do tema uso potencial da terra e canal de 

acordo com a tabela 13 (CIRILO et al., 2003; FLECKENSTEIN,1998; e SIMÕES, 2001 

apud ENGMAN, 1986) .  Após a preparação desta matriz passou-se a obtenção das 

outras matrizes (raio hidráulico – Rh e  da declividade – S)  

O coeficiente de rugosidade foi obtido através da reclassificação do mapa 

de potencial de uso do solo em junção com a drenagem extraída do mosaico SRTM 

da área de estudo. Os valores utilizados na reclassificação seguem na tabela 13. 
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TABELA 13.  
Coeficiente de rugosidade para canais naturais 

 

TIPO DE USO DO SOLO 
CLASSIFICAÇÃO  

SEPLAN 
RUGOSIDADE 

n 

Vegetação densa máxima (CIRILO, et 

al.,2003) 

Conservação Natural e 

Silvicultura 

0,16 

Corpos d’água (FLECKENSTEIN,1998) Rio Tocantins 0,01 

Pastagem (CIRILO, et al.,2003) Pecuária Extensiva e 

Intensiva 

0,025 

Culturas mínimas (CIRILO, et al.,2003) Culturas de ciclo curto e 

longo 

0,02 

Áreas sem uso ou urbana (SIMÕES, 

2001 apud ENGMAN, 1986) 

 

- 

0,01 

Fonte: autores diversos 

 

O outro parâmetro da equação de Manning é o Raio hidráulico que em 

escoamentos livres é a razão entre a área molhada ou de fluxo e o perímetro 

molhado. Porém, neste estudo, para obter a velocidade de toda a  bacia, foram 

valorados além dos canais de drenagem as áreas de terra, ou seja, (a) drenagens 

naturais e (b) escoamento superficial. 

Em escoamentos livres, nos canais de seção retangulares, faz-se o uso da 

largura como a profundidade de fluxo. Assim nas áreas terrestres a largura destas 

áreas está sendo tratada como profundidade e considera-se que o fluxo que forma 

uma fina camada com profundidade de 1mm, ou 0,001m. 

Com o uso do flowaccumulation no ArcInfo-ArMap obteve-se a rede de 

drenagem, onde o valor de cada célula indica o número de células que contribuem 

com suas águas superficiais. Delimitou-se um número pré-definido de células que 

iniciam rede fluvial, baseado em Usul (2002) que utilizou 1.000 células na grade de 10  

m x 10 m totalizando área de 0,10 Km2 e Fleckenstein (1998) que propôs início de 

drenagem com 100 células, formando uma área de 0,09 Km² (grade de 30 m x 30 m). 

Este estudo propôs o início de drenagens a partir de 10 células, em uma 

grade de 90 m x 90 m, tamanho do pixel da base utilizada – SRTM, Miranda (2005), 

totalizando uma área de contribuição de 0,081 Km² ou 81.000 m² ou 8ha. 
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Para as células restantes da matriz acumulada, que não estão formando 

redes de fluxo, a profundidade do escoamento superficial de 0,001 m é atribuída como 

valor R. 

O Raio Hidráulico foi obtido através do MNT, com aplicação das 

ferramentas do flowaccumlation e reclassify do ArcGis, utilizando os valores da tabela 

14, para cada sub-bacia, da área de estudo. 

 

TABELA 14. 
 Valores de Raio Hidráulico atribuídos a áreas de drenagem agrupadas. 

 
Valores de Fluxo Acumulado 

Raio Hidráulico 30 x 30 MNT 
(Fleckenstein, 1998) 

10 X 10 MNT 
(Usul, 2002) 

90 x 90 MNT 
(autora, 2010) 

0 -100 0 – 1000 0 - 10 0,001 

100 – 500 1000 – 5000 10 - 50 0,04 

500 – 1500 5000 – 15000 50 - 150 0,08 

1500 – 3500 15000 – 35000 150 - 350 0,12 

> 3500 > 35000 >350 0,25 
Fonte: Usul (2002), Fleckenstein (1998) e autora (2010). 
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Figura 9. Coeficiente de Manning combinado (terra e canal) da sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2009 
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Figura 10. Raio hidráulico da sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2009. 

 

Através da equação (14) obteve-se a velocidade de escoamento. 
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Figura 11. Mapa da velocidade de escoamento da sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2009. 

 

Foram obtidos os valores do SDR para cada sub-bacia com a aplicação da 

equação (7) que multiplicado pela produção total de sedimentos (A) resulta no aporte 

de sedimentos, de acordo com as etapas implementadas no ArcGis-ArcInfo: 

1. Extração de drenagem a partir das imagens SRTM: 

 A partir das imagens com as depressões removidas e o fluxo de 

direção gerado, proceder: Spatial Analyst Tool→Hydrology→Stream 

Order. No campo Input Stream Raster→Imagem com as depressões 

removidas; Input flow direction raster→Arquivo flow direction; Method 

of stream ordering→strahler. 

 A drenagem foi separada em ordens, devido ao excesso de 

informação foi aplicada a ferramenta Con, através do seguinte passo: 

Spatial Analyst Tools→Condicional→Con: input arquivo gerado a 

partir do stream order→Expression “value > 4. Input true raster→ 
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stream order. Não use input false. Output: Arquivo raster de 

condição. 

2. Obtenção do raster de distância à drenagem mais próxima: Spatial 

Analyst Tools→Distance→Path Distance , no campo Input raster  inserir 

o  raster de drenagem obtido no item 1. 

3. Produção do raster de rugosidade do n canal e n terra: 

 Reclassificação da drenagem do mapa de potencial de uso 

atribuindo valor nulo: Spatial Analist→Reclassify. Preencher new 

values com 0. 

 Obtenção do mapa de potencial de uso sobreposto à drenagem: 

Spatial Analyst→Raster Calculator: 

UsoTerraCanal=[potencialdouso]*[drenagemSRTM]; 

 Reclassificação conforme tabela de rugosidade: Spatial 

Analist→Reclassify. 

4. Reclassificação para Raio hidráulico.  

 A partir do arquivo de drenagem acumulada – flowaccumlation de 

cada sub-bacia, efetuou-se o agrupamento proposto neste estudo, 

considerando  o início da formação das drenagens a partir de 10 

células de contribuição. Spatial Analyst→ 

Reclassify→Classif→5classes→ no campo break values:10; 50; 150; 

350; >350. Preencher com os valores da tabela de Raio hidráulico 

New values:  0,001; 0,04; 0,08; 0,012; 0,25. 

5.  Obtenção da declividade – S em m/m: Spatial Analyst→Raster 

Calculator→slope_mm=[slope_mos]/100. Recortar o mosaico para as 

unidades de sub-bacias. 

6. Aplicação da fórmula de Manning (14) para obtenção da velocidade: 

Spatial Analyst→Raster Calculator V=(Pow([Rh], (2/3))*Pow([S], 0,5)) / 

[ntc] 

7. Cálculo do tempo de deslocamento ao longo da linha de escoamento e 

somatório do tempo de deslocamento (fluxo acumulado) para obtenção 

do tempo de fluxo ti a partir da célula i  até o seu exutório: 

 Spatial Analyst→Raster Calculator  ti=[PathDistance]/[velocidade]; 
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8. A opção Spatial Analyst→Raster Calculator: SDR=Exp([tempo de 

deslocamento ti]* -1). 

9. Para avaliar cada sub-bacia, utilizou-se como parâmetro a relação de 

aporte de sedimento tendo sido efetuadas as operações Spatial 

Analyst→Raster Calculator: Y = [arquivo Flow Accumulation] ([SDR]*[A – 

USLE] e por fim Spatial Analyst→Raster Calculator SDRbacia=( 

[Y]/[A])*100. 

 

Cada sub-bacia foi reclassificada, inferindo valores de 1 a 10 de acordo 

com as classes de aporte de sedimentos, quanto maior o SDR maior o nível de 

restrição de passagem da rodovia. Foi realizada a operação: Spatial Analyst 

→Reclassify. 

 

TABELA 16 
Aporte de sedimentos e taxa de liberação de sedimentos em função do tempo, 

correlacionado ao grau de penalização da área do estudo – região Jalapão – TO. 
 

 Sub-bacias 
Y (t/ano) 
 (tempo) 

SDR 
(%)(tempo) 

GRAU DE 
PENALIZAÇÃO 

T-9 Bacia do Rio das Balsas 638.101,4375 1,49 4 

T-9 Sub-bacia Córrego Caracol 2.442.885,500 91,45 10 

T-9 Sub-bacia Rio Ponte Altinha 6.901,6162 0.38 1 

T-9 Sub-bacia Rio Ponte Alta 64.227,7734 1,10 3 

T-10 Bacia do Rio Sono 229.323,2813 2,08 5 

T-10 Sub-bacia Rio Soninho2 33.314,4219 0,61 2 

T-10 Sub-bacia Rio Caracol 4.760.960,0000 91,69 10 

T-10 Sub-bacia Rio Monte Santo 7.598,8345 1,42 4 

T-10 Sub-bacia do Rio Soninho3 8.378,4990 0,78 2 

T-10 Sub-bacia Rio Novo 41.434,6836 0,47 1 

T-10 Sub-bacia Rio Preto 1.557.319,375 68,57 9 

T-10 Sub-bacia Rio Soninho  11.577,4580 0,89 3 

T-10 Sub-bacia Rio Vermelho 16.791,8672 0,98 3 
Fonte: Dados da pesquisa, 2010. 
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Figura 12. Mapa do aporte de sedimentos em função do tempo para a sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2009. 

 

B – SDR com a distância. 

 

A substituição do tempo de deslocamento pela distância de cada célula i a 

drenagem mais próxima, proporcionou a obtenção do aporte de sedimentos de cada 

sub-bacia, conforme resultado da tabela 16. 

 

 ii dSDR  exp  (15) 

 

A drenagem extraída a partir das imagens SRTM e a distância obtidas no 

procedimento: 

 A partir das imagens com as depressões removidas e o fluxo de 

direção gerado, proceder: Spatial Analyst Tool→Hydrology→Stream 

Order. No campo Input Stream Raster→Imagem com as depressões 
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removidas; Input flow direction raster→Arquivo flow direction; Method 

of stream ordering→strahler. 

 A drenagem foi separada em ordens, devido ao excesso de 

informação foi aplicada a ferramenta Con, através do seguinte passo: 

 Spatial Analyst Tools→Condicional→Con: input arquivo gerado a 

partir do stream order→Expression “value > 4. Input true raster→ 

stream order. Não use input false. Output: Arquivo raster de 

condição. 

 Obtenção do raster de distância à drenagem mais próxima: Spatial 

Analyst Tools→Distance→Path Distance , no campo Input raster  

inserir o  raster de drenagem obtido no item 1. 

 

 
Figura 13. Mapa das distâncias à drenagem da sub-bacia do rio Vermelho. 
Fonte: Dados da pesquisa, 2010. 

 

As operações realizadas no ArcInfo-ArcMap foram dividir a distância por 

1000, transformando de m para km e fazer a equação exponencial 15. 
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 Spatial Analyst→Raster Calculator  SDR=Exp([Distância da rede de 

drenagem]* -1)/1000. Seguem os resultados obtidos e a 

reclassificação das sub-bacias por grau de atrito. 

 

Procedeu-se os mesmos passos para obtenção do Y e do SDR e atribuição 

de grau de penalização às bacias, conforme utilizado na equação em função do 

tempo. 

 

TABELA 17. 
Reclassificação dos indicadores de aporte de sedimentos por sub-bacia e 

respectivo grau de penalização em função da distância. 
 

Fonte: Dados da pesquisa, 2010. 

 

 
RESTRIÇÃO SUB-BACIA 

DISSERTAÇÃO 
Y 

(t/ano)  
(distância) 

RELAÇÃO DE 
LIBERAÇÃO DE 
SEDIMENTOS 

% 

GRAU DE 
PENALIZAÇÃO 

T-10 Sub-bacia Rio Preto 887.700 39,09 (3) 

T-10 Sub-bacia Rio Novo 3.695.089 41,83 (4) 

T-10 Sub-bacia Rio Soninho 2 2.552.318 47,00 (4) 

T-9 Sub-bacia Rio Ponte Altinha 853.814 47,13 (5) 

T-10 Sub-bacia Rio Caracol 2.536.937 48,86 (6) 

T-10 Sub-bacia Rio Vermelho 876.449 51,17 (6) 

T-10 Sub-bacia do Rio Soninho 3 555.546 51,53 (7) 

T-10 Sub-bacia Rio Soninho 679.048 51,94 (7) 

T-9 Sub-bacia Rio Ponte Alta 3.046.370 52,33 (8) 

T-9 Bacia do Rio das Balsas 23.207.900 54,05 (8) 

T-10 Bacia do Rio Sono 7.942.678 55,23 (9) 

T-10 Sub-bacia Rio Monte Santo 298.415 55,83 (9) 

T-9 Sub-bacia Córrego Caracol 1.508.316 56,47 (10) 
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Figura 14. Mapa da classificação das bacias na área do estudo conforme taxa de aporte de sedimentos 
em função da distância – região Jalapão – TO. 
Fonte: Dados da pesquisa, 2009. 

 

4.3.5 Otimização do traçado da obra rodoviária 
 

A partir das informações obtidas nas etapas anteriores procedeu-se a 

aplicação da metodologia de SIG “Caminhos de Mínimo Custo” elaborando assim, um 

cenário para cada critério: aspecto ambiental, aspecto construtivo e aspecto 

socioeconômico. 

Para a melhor alternativa de traçado foi obtido o caminho de menor custo, 

considerando os atritos aplicados. Com o uso das ferramentas do ArcGis-ArcMap-

ArcInfo o módulo distance produziu valores de distância medidos em metros até a 

sede municipal Lagoa do Tocantins e o cost calculou  a distância em termos de 

medida de custo indicando o custo relativo do deslocamento através de cada célula 

(pixel). 
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De posse das superfícies de custo, utilizou-se o comando pathway para 

encontrar o caminho de menor custo entre qualquer célula ou grupo de células e os 

pontos a serem interligados. 

 Criar matriz de distância a partir de Lagoa do Tocantins Spatial 

Analyst→Distance→Cost Weighted, preencher o campo Distance to 

com a shape do ponto de origem a ser ligado →Lagoa do Tocantins, 

preencher o campo de pesos Cost raster →ambientais, ativar create 

direction e apontar para o diretório onde o arquivo será salvo; 

 Obter o caminho mínimo: Spatial Analyst→Distance→Shortest Path, 

preencher o campo de Path to com o destino Mateiros, preencher o 

campo de Cost Distance com a matriz de distância obtida 

anteriormente, preencher Cost direction raster com a matriz de 

direção gerado anteriormente e no campo Path type usar For each 

cell. 

 

A partir dos 4 mapas de atrito do aspecto ambiental obteve-se uma matriz 

única ambiental com as seguintes operações de soma: Spatial analyst→Raster 

Calculator Atrito amb=([aporte sedimentos]+[app nascentes]+[uc]+[dificuldade - uso e 

ocupação]+[zona tampão]). 

Efetuaram-se os mesmos procedimentos para o aspecto construtivo e 

finalmente aplicou-se o cálculo do caminho de mínimo custo sobre os mapas de custo 

específicos e obtendo-se a altenativas de traçado para cada aspecto e combinados 

integrando todos os quesitos estudados. 

Para a otimização do traçado final foi aplicado o algoritmo de caminho de 

mínimo custo, através da soma dentro dos aspectos e a ponderação entre os 

aspectos para igualar os pesos. 
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5 ANÁLISE E DISCUSSÃO DOS RESULTADOS. 

 

A vontade de promover a construção de uma sociedade mais sustentável 

movida pela busca de ações com menor agressão ao meio ambiente tem 

fundamentado as discussões mundiais sobre o assunto. Uma vez verificado que 

problemas ambientais decorrem, em grande parte, das carências do processo 

decisório que orienta a utilização dos recursos ambientais este trabalho propôs utilizar 

uma importante ferramenta da política ambiental, a avaliação de impacto ambiental 

estratégica para o setor de transporte, especificamente para projetos rodoviários que 

induzem o desenvolvimento econômico regional, através do uso de Sistema de 

Informação Geográfica. 

A contribuição deste projeto é dada através do dimensionamento dos 

impactos efetivos da rodovia TO-247, através da ampliação das áreas de influência 

para além das faixas lineares, acrescentando a avaliação da sensibilidade ambiental 

das bacias hidrográficas ou o custo ambiental respectivo para a otimização do traçado 

de empreendimentos rodoviários. 

A área de influência da rodovia foi estendida para as sub-bacias 

impactadas através da modificação do uso do solo movida pela redução dos custos de 

transporte induzida pela melhoria de infraestrutura viária na região do Jalapão - TO. 

Foram obtidas estimativas de carga de sedimentos por bacia, que 

potencialmente viriam a assorear os cursos d’água devido a conversão para uso 

potencial das terras, por meio da classificação das sub-bacias, através da aplicação 

da Equação Universal de Perdas de Solo e da Relação de Aporte de Sedimentos . 

O uso de ferramentas do ArcGisArcMap, através de imagens SRTM e da 

classificação dos mapas de potencial de uso do solo, pedologia, hidrografia e de 

declividade  para obtenção dos dados, propiciaram a obtenção dos resultados abaixo 

descritos na tabela 18. 
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TABELA 18. 
Valores de perdas de solo, obtidos através da equação universal de perdas de solo – USLE para as sub-bacias da área do 

estudo na região Jalapão - TO. 
 

 Sub-bacias USLE-acumulada 
t/ano 

Y – t/ano 
f(distância) 

SDR (%)  
f(dist.) 

Y- t/ano  
f(tempo) 

SDR  (%)  
f(tempo) 

T-9 Bacia do Rio das Balsas 42.935.264,0000 23.207.900,0000 54,05 638.101,4375 1,49 
T-9 Sub-bacia Córrego Caracol 2.671.197,0000 1.508.316,7500 56,47 2.442.885,500 91,45 
T-9 Sub-bacia Rio Ponte Altinha 1.811.669,7500 853.814,1250 47,13 6.901,6162 0.38 
T-9 Sub-bacia Rio Ponte Alta 5.821.944,5000 3.046.370,2500 52,33 64.227,7734 1,10 
T-10 Bacia do Rio Sono 14.382.113,0000 7.942.678,5000 55,23 229.323,2813 2,08 
T-10 Sub-bacia Rio Soninho2 5.430.590,5000 2.552.318,5000 47,00 33.314,4219 0,61 
T-10 Sub-bacia Rio Caracol 5.192.525,0000 2.536.937,7500 48,86 4.760.960,0000 91,69 
T-10 Sub-bacia Rio Monte Santo 534.507,3125 298.415,3125 55,83 7.598,8345 1,42 
T-10 Sub-bacia do Rio Soninho3 1.078.141,2500 555.546,3750 51,53 8.378,4990 0,78 
T-10 Sub-bacia Rio Novo 8.833.079,0000 3.695.089,7500 41,83 41.434,6836 0,47 
T-10 Sub-bacia Rio Preto 2.271.181,5000 887.700,6250 39,09 1.557.319,375 68,57 
T-10 Sub-bacia Rio Soninho  1.307.405,0000 679.048,8750 51,94 11.577,4580 0,89 
T-10 Sub-bacia Rio Vermelho 1.712.663,1250 876.449,0625 51,17 16.791,8672 0,98 

Fonte: Dados da pesquisa (2010). 
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Foi observada grande variabilidade nos valores de produção média de 

sedimentos entre as 13 sub-bacias avaliadas, já tendo sido verificado por outros 

autores (FARINASSO et al.,2006 e COSTA et al., 2007) que a utilização da USLE 

serve para verificações de graus de susceptibilidade à erosão qualitativamente e 

geograficamente em grandes áreas ou escalas regionais, não quantitativamente. 

Para o estudo, os valores são indícios da quantidade de sedimento 

produzida e foi utilizado para efeito comparativo de suscetibilidade das sub-bacias à 

ocupação prevista pelo potencial de uso do solo. No caso, a sub-bacia do rio das 

Balsas destacou-se com a maior produção total anual de sedimentos de 42.965.264 

t/ano e a sub-bacia do rio Monte Santo com a menor produção 534.507,3125 t/ano. 

Porém, foi fundamental o conhecimento da relação de liberação de sedimentos, pois 

refletiu o potencial de retenção destes sedimentos em cada área estudada e o aporte 

aos cursos d’água, tendo sido pontuada com pesos as sub-bacias de acordo com esta 

taxa. 

 

 
Figura 15. Mapa da produção total de sedimentos da sub-bacia do rio Vermelho – região Jalapão – TO. 
Fonte: Dados da pesquisa, 2009. 
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A relação de aporte de sedimentos foi obtida através de dois métodos, com 

o decaimento exponencial em função da distância e no segundo caso, em função do 

tempo. Com a aplicação da distância os valores variaram de 39,09% a 56,47%, 

classificando as sub-bacias do rio Preto e do córrego Caracol, com menor e maior 

restrição de passagem da rodovia respectivamente. Neste caso, a sub-bacia do 

córrego Caracol contribuiria com o aporte de 2.442.885,5 t de sedimentos em um 

ano, enquanto que a do rio Preto 877.700 t/ano (Tabela 18). 

 

 
Figura 16. Mapa do aporte total de sedimentos em função da distância da sub-bacia do rio Vermelho – 
região Jalapão – TO. 
Fonte: Dados da pesquisa, 2009. 

 

Os valores de aporte de sedimentos em função da distância variaram em 

percentuais mínimos a máximos entre 0,61% a 91,69%, respectivamente, apesar de 

levar em consideração maior número de fatores, o que se esperava uma maior 

precisão de resultados, porém mostrou-se ineficiente para a classificação das bacias, 
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tendo sido descartados estes dados. As velocidades de escoamento obtidas com o 

uso do coeficiente de Manning resultaram em altos valores absolutos, inapropriados 

para a situação específica. Outros trabalhos poderão ser desenvolvidos para avaliar 

as metodologias estudadas, considerando bacias com dimensões menores e uso e 

cobertura do solo, mais variável (Tabela 18). 
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TABELA 19. Comparativo de grau de penalização dos aspectos ambientais, construtivos e socioeconômicos. 

  
ASPECTOS AMBIENTAIS ASPECTOS CONSTRUTIVOS 

ASPECTOS 
SOCIO-

ECONÔMICOS 
Nível de 
restrição 

Grau de 
penalização USO DO SOLO UC APP DAS 

NASCENTES 
APORTE - SDR 

BACIAS 
TRAVESSIA DE 

CURSOS D'ÁGUA  
GRADIENTE 
DE RAMPA 

PONTOS 
TURÍSTICOS 

Barreira 
Absoluta 

1000 Praias e Dunas 
(1000) 

Estação 
Ecológica  

(1000) 

APP de todas a 
nascentes     

(1000) 

   Dunas e 
Cachoeira (< 
1km)  (1000) 

Nenhum 1 Corpos d’água  (1) Sem uc (1) Áreas alem do 
100m da zona 

tampão. (1) 

    Declive ≤ 10% 
(1) 

5 > D ≤ 1  (1) 

Baixo 2 Áreas rurais 
antropizadas (2) 

   Bueiros tubulares - 
BSTC (2) 

10% >declive 
≤15% e 

associações (2) 

10 > D ≤ 5 (2) 

3 Vegetação Nativa 
- Campestre (3)  

Área de 
Proteção 

Ambiental (3) 

 Rio Preto (3)   15 > D ≤ 10 (3) 

Médio 4    Rio Novo e do Rio 
Soninho 2 (4) 

 15% > declive ≤ 
30% e ass. (5) 

20 Km > D  ≤ 15 
Km (4) 

5 Vegetação Nativa 
– florestal e 
savânica (5) 

  Rio Ponte Altinha (5) Bueiros celulares - 
BSCC ou galerias 

(5) 

  

Alto 6 Vegetação Nativa 
ass. corpos d’água 

(6) 

  Rio Caracol e do Rio 
Vermelho (6) 

Pontes - PCA  (6)  D > 20 km (6) 

7 Áreas urbanas (7)   Rio Soninho 3 e do 
Rio Soninho (7) 

Pontes - PCA  (7)   

Muito Alto 8    Rio Ponte Alta e Rio 
das Balsas (8) 

 30%> declive  ≤ 
45%    (8) 

 

9    Rio Sono e Rio Monte 
Santo (9) 

   

Excessivo 10   Parque e 
Área Indígena 

(10)  

Zona tampão - 
do curso d´água 

(10) 

Córrego Caracol (10)   Declive > 45%    
(10) 

  

Fonte: Dados da pesquisa, 2010.
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5.1 Análise comparativa das alternativas locacionais 

 

Para análise comparativa dos caminhos de mínimo custo, onde a 

alternativa resultante como melhor traçado foi obtido como distância de custo e 

caminhos de mínimo custo, considerando-se as superfícies de atrito propostas, sendo 

que cada pixel representa a distância, segundo uma direção em diagonal ou paralela, 

dividiu-se os resultados da seguinte forma: 

 Alternativa A: caminho de mínimo custo considerando os aspectos 

ambientais; 

 Alternativa B: caminho de mínimo custo para aspectos construtivos; 

 Alternativa C: caminho de mínimo custo para aspecto socioeconômico; 

 Alternativa D: caminho de mínimo custo para combinação entre os aspectos 

ambientais, construtivos e socioeconômico. 

 

5.1.1 Avaliação da alternativa A – aspectos ambientais 
 

Este traçado integrou 4 aspectos ambientais, sendo os atritos referentes à 

cobertura e uso do solo, proteção das APP’s das nascentes e zona tampão,  áreas 

protegidas e capacidade das sub-bacias em aporte de sedimentos. 

O traçado foi a resultante da soma dos graus atribuídos aos 4 mapas de 

atrito conforme a nível de restrição. 

A Figura 17 demonstra o resultado alcançado na pesquisa, considerando 

exclusivamente os aspectos ambientais. 
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Figura 17. Mapa da Alternativa A – aspecto ambiental para a rodovia TO-247, trecho Lagoa do 
Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

Tendo sido identificado impactos ambientais nos cursos d’água devido à 

proximidade das rodovias por Catellani, Targa e Batista (2005)  e recomendado por 

Simões (2001) um afastamento mínimo de 100m dos mesmos para instalação de 

rodovias, como zona tampão de maior eficiência, além da legislação de proteção das 

APP’s das nascentes, obteve-se o resultado verificado na Figura 18 de detalhamento 

da alternativa A. 

O caminho de mínimo custo ambiental mostrou eficiência para proteção 

dos temas propostos.  
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Figura 18. Detalhamento da Alternativa A para a rodovia TO-247, trecho Lagoa do Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

Ainda neste aspecto, verificam-se na Figura 18, através de tentativas de 

melhor traçado ambiental, os limites do Parque Estadual do Jalapão e da Estação 

Ecológica Serra Geral do Tocantins, em algumas extensões dos seus perímetros, não 

seguem os limites dos divisores das bacias. Ao aplicar a metodologia pode-se verificar 

que passar por diversos cursos d’água, suas APP’s e zonas tampões pode apresentar 

um custo ambiental maior que adentrar nas áreas protegidas, caracterizando um 

indicativo para demarcação de unidades de conservação, considerando as bacias 

como unidade ambiental. 

Para obter sucesso no afastamento das rodovias em relação às unidades 

de conservação e ainda manter uma distância mínima, aplicaram-se pesos de máxima 

restrição, grau 10, ao Parque Estadual do Jalapão, e ainda impôs-se barreira absoluta 

à Estação Ecológica Serra Geral, resultando em pequena interferência no Parque 

Estadual e a maior parte do traçado desenvolveu-se na Área de Proteção Ambiental – 

APA do Jalapão, considerada de uso sustentável (Figura 19). 
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Figura 19. Relação da Alternativa A com as UC’s para a rodovia TO-247, trecho Lagoa do Tocantins / 
Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

As 13 sub-bacias da área de estudo foram classificadas conforme a taxa de 

liberação de sedimentos, ilustrado na Figura 20, resultando em uma superfície de 

custo que inseriu os impactos ambientais destas unidades considerando os seus 

limites. Pode-se observar que o caminho de mínimo custo da alternativa A, partiu da 

sub-bacia do rio das Balsas (grau 8) e seguiu pelas sub-bacias de menor peso:  sub-

bacia do rio Soninho (7), sub-bacia do rio Vermelho (6), sub-bacia do rio Novo (4)e 

sub-bacia do rio Preto (3). 
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Figura 20. Relação da Alternativa A com as sub-bacias para a rodovia TO-247. 
Fonte: Dados da pesquisa, 2010. 

 

5.1.2 Avaliação da alternativa B – aspectos construtivos 
 

Os aspectos construtivos foram representados pela alternativa de traçado B 

que incorporou as dificuldades construtivas de travessia de drenagens, o que pode ser 

traduzido pela escolha entre construção de bueiros tubulares, bueiros celulares ou 

galerias e pontes, assim, ficando expressa a dificuldade de travessia sobre drenagens 

iniciais ou em hierarquia maior. Considerando que o arquivo raster das drenagens foi 

elaborado sobre pixels de 91 X 91 m, a passagem sobre valores mais altos de 

restrição nas drenagens tem menor significado na somatória final em relação à menor 

distância, assim verifica-se a definição do traçado com o delineamento de uma reta. 
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Figura 21. Mapa da Alternativa B – aspecto construtivo, para a rodovia TO-247, trecho Lagoa do 
Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

O atrito do aspecto construtivo referente ao gradiente de rampa, foi 

ressaltado no trecho da rodovia TO-247 em que resultou em mudança de direção nas 

proximidades da Serra do Espírito Santo, quando há ocorrência de declividade maior 

que 45º, atribuída restrição excessiva (grau 10), demonstrado em detalhe na Figura 

22. 
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Figura 22. Detalhamento da alternativa B para a rodovia TO-247, trecho Lagoa do Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 
5.1.3 Avaliação da alternativa C – aspectos socioeconômicos 

 

A alternativa C resultante da aplicação do caminho de mínimo custo na 

ligação das sedes municipais e a melhoria dos acessos aos principais pontos 

turísticos, está representada na Figura 23. 

A resultante do caminho mínimo adentra os buffers efetuados de acordo 

com a classificação de distância proposta buscando levar o benefício do projeto de 

pavimentação asfáltica da TO-247 o mais próximo possível dos pontos turísticos. 

Porém, conseguiu evitar os impactos diretos do empreendimento sobre a 

faixa de até 1km, permitindo este afastamento através do buffer de distância em que 

foi atribuído valor 1000. 
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Figura 23. Mapa da Alternativa C - aspecto socioeconômico para a rodovia TO-247, trecho Lagoa do 
Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

5.1.4 Avaliação da otimização final do traçado -  Alternativa D 
 

O procedimento de ponderação dos pesos para obtenção do traçado final 

foi proposto visando a padronização dos fatores de decisão. No caso, foram atribuídos 

pesos iguais a todos os aspectos, porém, a discussão da importância relativa de cada 

atrito em relação ao outro pode exigir a participação de técnicos e decisores com 

variados níveis de conhecimento.  

A ponderação aplicada foi a multiplicação dos aspectos ambientais por 1 

somado à multiplicação dos aspectos construtivos por 2, somado ainda a 

multiplicação do aspecto socioeconômico por 4, terminando por dividir o total da 

operação por 7, que são o número de temas de atrito. 

A alternativa de traçado A que integrou os aspectos ambientais apresentou 

uma extensão de 144,43 km, sendo o maior valor entre os traçados estudados. Já no 
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caso dos aspectos construtivos, a alternativa B, totalizou 137,10 km. Considerando 

somente o aspecto socioeconômico, a alternativa de traçado C como caminho 

mínimo, resultou em 136,63 km, a menor extensão total. 

A alternativa A, dos aspectos ambientais, resultou em uma extensão 

maior, considerando a necessidade de buscar os pixels de menor valor, 

proporcionando o afastamento dos cursos d’água, seguindo pelos divisores das sub-

bacias. Contribuiu para o aumento da extensão a cobertura e uso do solo, onde 

predominou a ocorrência de vegetação nativa e a busca por uma passagem de 

menor restrição entre as unidades de conservação que formaram grandes áreas 

homogêneas no custo de passagem. 

Quanto ao custo por quilômetro para implantação de rodovias, pode 

aparentar que a melhor alternativa é somente a de aspectos socioeconômicos, ou 

seja a alternativa C, de trajeto mais curto. Porém, em uma avaliação de custo efetivo 

o resultado final pode variar em função da necessidade de desmatamento, 

compensação ambiental em unidades de conservação, além dos custos 

relacionados a construção de obras de arte e execução de cortes e aterros. 

A resultante final dos três aspectos estudados caracterizou-se por uma 

extensão total de 143,19 km, sendo observado que esta alternativa adentrou o 

Parque Estadual do Jalapão em uma extensão total pouco maior que na alternativa 

ambiental, porém menor no aspecto construtivo e socioeconômico. Este fator pode 

ser amenizado com a proposição de medidas mitigadoras dos impactos, a exemplo 

de implantação de estrada parque, construção de passagens de fauna e proposição 

de projetos de apoio ao desenvolvimento sustentável na região. 

Ainda, foram incorporados ganhos no traçado otimizado final, com 

afastamento da Serra do Espírito Santo, pela face sul, uma vez que a proposição da 

alternativa dos aspectos construtivos contornava a mesma Serra pela face norte, 

aumentando a extensão de travessia do Parque. 
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Figura 24. Resultado da otimização de rota – alternativa de traçado D para a rodovia TO-247, trecho 
Lagoa do Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

Quanto ao aspecto socioeconômico, foi verificada uma aproximação maior 

das Dunas, localizando o traçado na faixa de distância entre 5 e 10 km, sendo que 

na Cachoeira da Velha tocou somente no buffer da distância maior que 15 km e 

menor que 20 km. Assim, o resultado foi considerado satisfatório para a conjunção 

dos aspectos, uma vez  que a aproximação proposta pelo traçado final D aproximou 

a rodovia dos pontos turísticos adentrando o mínimo possível no Parque Estadual, 

além de evitar totalmente a Estação Ecológica , com passagem vedada a projetos de 

pavimentação de vias. 
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Figura 25. Mapa da otimização de rota – alternativa de traçado D para a rodovia TO-247 sobre imagem 
CBERS, trecho Lagoa do Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 

 

5.1.5 Inserção das bacias hidrográficas na avaliação de impactos ambientais de 
rodovias  

 

O produto final obtido da aplicação da metodologia, sob o aspecto 

proposto nesta pesquisa, que é a contribuição obtida à tomada de decisão 

estendendo os limites da área de influência das rodovias para os limites das bacias 

hidrográficas, pode ser verificado na Figura 28. 

A alternativa A, dos aspectos ambientais foi mais precisa na incorporação 

deste fator, visto que a otimização do traçado final, resultou em desvio de pequena 

extensão para a bacia do rio Sono, classificada no estudo com nível de atrito muito 

alto, grau 9. Porém a maior extensão da rodovia desenvolveu-se sobre a sub-bacia 

do rio Novo, com média restrição e grau de penalização 4. 
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A integração de todos os aspectos é uma difícil tarefa para os tomadores 

de decisão, no caso do estudo, a necessidade de aproximação do ponto turístico 

Cachoeira da Velha provocou o desvio para uma bacia de maior atrito, porém não 

comprometendo o resultado final. Há que se considerar que a classificação das sub-

bacias propostas pela SEPLAN (TOCANTINS, 2008) introduz duas sub-bacias de 

grandes dimensões na pesquisa, uma delas a sub-bacia do rio Sono, caso em 

questão, com 6.984 km2 de área. Através de uma nova reclassificação, subdividindo 

esta sub-bacia de grande extensão e área, poderiam ser obtidos outros valores, 

sendo necessários novos limites, em um exemplo simples a área de influência 

atingiria somente a sub-bacia do ribeirão Peixinho, caso para um outro estudo. 

Ressalta-se que um dos pontos a serem interligados (Lagoa do Tocantins) 

está localizado sobre a bacia do rio das Balsas a segunda maior área, também com 

nível alto de restrição, grau 8, porém como no algoritmo é a meta a ser alcançada, 

não pode ser contornada. 

 
Figura 26. Mapa da área de influência direta delimitada por buffer de 5 km, comparada a área de 
influência delimitada pelas sub-bacias para a rodovia TO-247, trecho Lagoa do Tocantins / Mateiros. 
Fonte: Dados da pesquisa, 2010. 
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Figura 27. Mapa da área de influência indireta representada pelas sub-bacias e buffer de 30 Km, para a 

alternativa otimizada da rodovia TO-247, trecho Lagoa do Tocantins / Mateiros. 
 

A área de influência indireta, delimitada através de uma área afastada até 

30 Km do eixo estradal, na maioria dos estudos ambientais está representada na 

Figura 27 comparada a área de influência delimitada pelas sub-bacias estudadas. 

Pode-se observar que o trabalho definiu a área de influência com 

propriedades técnicas mais consistentes, considerando a bacia como um limite 

geográfico que reflete os possíveis impactos ambientais indiretos da implantação 

das rodovias. 
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6  CONCLUSÕES 

 

Esta pesquisa proporcionou uma análise sobre os impactos ambientais 

advindos de rodovias, sob a ótica catalisadora da ocupação de uma região, 

principalmente das áreas lindeiras às estradas pavimentadas, devido à redução dos 

custos do transporte e melhorias de acesso, impondo novos limites à área de 

influência que um traçado condiciona. 

A principal motivação e novidade do trabalho é a irradiação da área de 

influência de projetos rodoviários para os limites das bacias hidrográficas 

impactadas. 

Com a classificação da capacidade de aporte de sedimentos das sub-

bacias da área do estudo, a otimização de rotas possíveis considerou a 

sensibilidade das bacias hidrográficas, como um mecanismo de transporte de 

problemas de montante a jusante. 

Em um primeiro momento a decisão de uma política pública, parte de 

fatores socioeconômicos, quando uma rodovia integra o planejamento para o 

desenvolvimento regional, através da ligação de pontos de importância, seja de 

comunidades de centros urbanos, rodovia troncal ou pontos de interesse econômico 

como o caso da pesquisa, interesse turístico. 

Porém ao ser requisitado a elaboração do projeto de engenharia para a 

implantação e pavimentação de rodovias, onde são apresentadas as alternativas de 

traçados, utiliza-se na maioria estudos hidrológicos que seguem as informações 

topográficas existentes nas cartas planialtimétricas do Instituto Brasileiro de 

Geografia e Estatística - IBGE, em escala inadequada 1:1.000.000, sendo 

apresentado projeto de traçado rodoviário considerando apenas as dificuldades 

construtivas, deixando de observar os aspectos ambientais, Este trabalho 

considerou as dificuldades construtivas propondo o uso de dados planialtimétricos 

obtidos por técnicas de sensoriamento remoto, das imagens SRTM que se 

mostraram como alternativa para a obtenção de informações do relevo e para a 

otimização de rotas de rodovias, e integrou os aspectos ambientais na definição dos 

traçados rodoviários. 

Concluiu-se pelos seguintes aspectos: 

 A unidade geográfica bacia hidrográfica, avaliada através do uso 

da equação universal de perdas de solo e da taxa de liberação de 
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sedimentos foi considerada como limite mais adequado da área de 

influência do projeto rodoviário da TO-247, contribuindo para a 

ampliação do conhecimento sobre os impactos ambientais destes 

empreendimentos, colaborando para a tomada de decisão na fase 

de planejamento. 

 A metodologia aplicada para a definição de alternativa de traçado 

para a rodovia TO-247, no trecho estudado pode definir um traçado 

condicionado aos aspectos ambientais juntamente com os 

construtivos e socioeconômicos. 

 O uso de ferramentas do SIG, com o algoritmo de mínimo custo 

proporcionou a definição de alternativas locacionais com a inserção 

de propriedades técnicas, podendo ser útil na avaliação ambiental 

estratégica de projetos rodoviários onde prevalece a falta de 

conhecimento prévio da capacidade de suporte dos ecossistemas a 

nível de apropriação dos seus recursos, como no Jalapão – TO . 

 

Destacou-se nesta pesquisa, a incorporação dos aspectos ambientais 

relevantes, muitas vezes cerceadas a um segundo plano na fase de elaboração do 

projeto, para serem exigidas somente na fase de licenciamento ambiental que 

precede a implantação da obra, com detalhamento técnico cada vez maior.  

Para este estudo, os impactos no meio físico são considerados os mais 

relevantes e estão contemplados através da classificação das bacias quanto a 

produção e transferência dos sedimentos. A aplicação da equação universal de 

perdas de solo – USLE obtida através da base de dados disponível gratuitamente 

em site na internet e o uso do sensoriamento remoto mostrou-se como ferramentas 

de suporte na qualificação das bacias, quando foi associado a taxa de transferência 

de sedimentos. 

O estudo aplicou uma modelagem bastante útil para estimar a distribuição 

espacial de sedimentos para bacias de qualquer tamanho, estimando o SDR em 

uma base matricial, interagindo vários fatores como uso e cobertura do solo, 

declividade, comprimento de rampa entre outros. O emprego dos métodos de 

obtenção de produção de sedimentos e taxa de liberação dos sedimentos resultou em 

grande variabilidade de valores, não devendo ser tomado para fornecer boas 
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estimativas absolutas, porém considerados indicadores relativos quanto aos 

sedimentos produzidos nas sub-bacias e carreados para os cursos d’água. 

Ainda foram relacionados no atrito ambiental os temas de Unidades de 

Conservação e áreas de importância ecológica, aplicação de restrição à zona 

tampão de 100m, restrição máxima à travessia de APP de nascentes e variados 

níveis de restrição a passagem sobre áreas com cobertura e uso do solo com 

vegetação nativa, áreas urbanas e uso agropecuário. 

Todos os atritos integrados na programação dinâmica dos algoritmos de 

mínimo custo, em SIG, proporcionou a sistematização de informações, integrando os 

aspectos ambientais, construtivos e socioeconômicos, traduzindo-se em uma 

importante ferramenta para uso em avaliações ambientais. Podem ser aplicados 

outros critérios, conforme as características regionais, ou os assuntos apresentados 

como prioritários, possibilitando a incorporação de novos temas e o enriquecimento 

dos debates entre as áreas especificadas. 

Pode-se concluir que o modelo proposto, em obras viárias classificadas 

como indutoras de desenvolvimento, vem contribuir para os tomadores de decisão em 

fase preliminar, integrando propriedades técnicas consistentes a proposta de uma 

alternativa de traçado de uma rodovia. 

Espera-se que esta metodologia possa colaborar, também, para a 

apropriação e uso de informações disponíveis de fácil acesso e o enriquecimento do 

conhecimento dos fatores de decisão, principalmente com a inclusão dos aspectos 

ambientais relevantes a serem considerados na implantação e pavimentação de 

rodovias. 

Ressalta-se que a adoção deste modelo não elimina os trabalhos de 

campo, mas sim complementam as pesquisas, no que se refere à avaliação 

ambiental estratégica. 
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7  RECOMENDAÇÕES 

 

Seguem as recomendações resultantes do trabalho: 

• Considerar os limites das bacias hidrográficas nos estudos ambientais, 

como limites da área de influência de empreendimentos rodoviários; 

• Promover a institucionalização da Avaliação Ambiental Estratégica de 

modo simplificado e ágil, como processo para sustentar decisões sobre 

a implantação de projetos rodoviários indutores de desenvolvimento; 

• Incluir nas normas técnicas ou instruções de serviços de projetos 

rodoviários a apresentação de alternativas de traçado considerando os 

aspectos ambientais; 

• Fortalecer o banco de dados nos setores de infraestrutura rodoviária 

governamentais, com vistas ao uso da ferramenta do 

geoprocessamento, buscando a aplicação das informações existentes 

na fase de planejamento de obras de pavimentação asfáltica. 

Em trabalhos futuros podem ser incorporados os impactos sobre a fauna, 

sendo necessárias informações sobre séries de monitoramentos, para nortear a 

proposta, ou abordagem quanto à importância dos fragmentos florestais como habitat 

para a fauna e a conectividade entre eles. Neste último caso, poderiam ser utilizados 

modelos matemáticos para uso em SIG (CIOCHETI, 2006).  Outros aspectos como 

qualidade do ar e produção de ruídos também podem ser considerados em rodovias 

que atravessam áreas de concentração urbana.  

O aproveitamento de estradas existentes no desenvolvimento do projeto de 

pavimentação não foi considerado, pois não se aplica ao caso do estudo devido a 

escassez de acessos na região, porém a adequação do traçado geométrico a 

estradas existentes é comum neste tipo de projeto, evitando abertura de novas áreas, 

ou efetuando o aproveitamento de obras de arte construídas anteriormente. 

A distância das jazidas de cascalho, areia e brita são fatores que poderiam 

ser estudados, pois oneram os custos das obras, conforme a distância e o quantitativo 

de material, porém não foi trabalhado nesta escala de trabalho, devido à falta de 

informações sobre o tema nesta fase do projeto rodoviário. 

Quanto ao aspecto socioeconômico a vontade de aproximação de 

localidades como povoados, vilas ou outras sedes municipais – entre as sedes 

municipais que são pontos obrigatórios a serem interligados, proporcionando o 
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benefício da aproximação da rodovia pavimentada, sem porém ser obrigatória a 

passagem pelo ponto e até situações em que já tenham sido construídas obras de 

arte (pontes) que devam ser aproveitadas. 
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APÊNDICES 

 
APÊNDICE A - MAPA DE ERODIBILIDADE DOS SOLOS (K) DA ÁREA DO ESTUDO 

PARA APLICAÇÃO NA EQUAÇÃO UNIVERSAL DE PERDAS DE SOLOS. 
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APÊNDICE B - MAPA DO FATOR DE USO E MANEJO DOS SOLOS (C) OBTIDO 

PARA A ÁREA DO ESTUDO, PARA APLICAÇÃO NA EQUAÇÃO UNIVERSAL DE 

PERDAS DE SOLOS. 
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APÊNDICE C – MAPAS DO FATOR TOPOGRÁFICO – LS DAS BACIAS DA ÁREA 

DO ESTUDO – REGIÃO JALAPÃO PARA APLICAÇÃO NA USLE. 
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Continua APÊNDICE C – MAPAS DO FATOR TOPOGRÁFICO – LS DAS BACIAS 

DA ÁREA DO ESTUDO – REGIÃO JALAPÃO PARA APLICAÇÃO NA USLE. 
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APÊNDICE D – MAPA DA PRODUÇÃO DE SEDIMENTOS (A) DA ÁREA DO 

ESTUDO, OBTIDO ATRAVÉS DA EQUAÇÃO UNIVERSAL DE PERDAS DE SOLOS. 
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APÊNDICE E – MAPA DO COEFICIENTE DE MANNING – “n” COMBINADO 

(TERRA+CANAL) DA ÁREA DO ESTUDO – REGIÃO JALAPÃO – TO PARA 

OBTENÇÃO DO SDR (t). 
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Continua APÊNDICE E – MAPAS DO COEFICIENTE DE MANNING – “n” 

COMBINADO (TERRA+CANAL) DAS BACIAS DA ÁREA DO ESTUDO - SDR (t).
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APÊNDICE F – MAPAS DO RAIO HIDRÁULICO PARA AS BACIAS DA ÁREA DO 

ESTUDO – REGIÃO JALAPÃO – TO, PARA OBTENÇÃO DO SDR (t). 
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Continua APÊNDICE F – MAPAS DO RAIO HIDRÁULICO PARA AS BACIAS DA 

ÁREA DO ESTUDO – REGIÃO JALAPÃO – TO, PARA OBTENÇÃO DO SDR (t). 
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APÊNDICE G – MAPAS DO TEMPO E DA VELOCIDADE DE ESCOAMENTO DA 

BACIA DO RIO VERMELHO PARA O CÁLCULO DA SDR (t) 
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APÊNDICE H – MAPA DE ATRITO DO USO POTENCIAL DO SOLO – ASPECTOS 

AMBIENTAIS 
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APÊNDICE I – MAPA DE ATRITO DE UNIDADES DE CONSERVAÇÃO E ÁREAS 

PROTEGIDAS – ASPECTOS AMBIENTAIS. 
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APÊNDICE J – MAPA DE ATRITO DAS APP’S DAS NASCENTES E ZONA TAMPÃO 

DOS CURSOS D’ÁGUA – ASPECTOS AMBIENTAIS. 
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APÊNDICE L – MAPA DO ATRITO DE OBRAS DE ARTE – ASPECTOS 

CONSTRUTIVOS. 
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APÊNDICE M – MAPA DE ATRITO DE GRADIENTE DE RAMPA – ASPECTOS 

CONSTRUTIVOS 

 

 

 

 


